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Introduction 

1.1 Background  

Building Information Modeling (BIM) is one of the most promising developments 

in the architecture, engineering, and construction (AEC) industries. With BIM 

technology, one or more accurate virtual models of a building are constructed 

digitally. They support design through its phases, allowing better analysis and 

control than manual processes. When completed, these computer-generated 

models contain precise geometry and data needed to support the construction, 

fabrication, and procurement activities through which the building is realized. 

BIM also accommodates many of the functions needed to model the lifecycle of a 

building, providing the basis for new design and construction capabilities and 

changes in the roles and relationships among a project team. When adopted well, 

BIM facilitates a more integrated design and construction process that results in 

better quality buildings at lower cost and reduced project duration [1]. 

A strong need for a comprehensive tool which allows architects, engineers and 

contractors to simulate and visualize construction sequences as part of an 

interactive experience is arise. The 4D model provides the basis for a common 

language between all parties and a representation of the schedule itself [2]. 

Gantt chart technique for project planning has a long been popular technique, but 

it lack something to be desired when it comes to visualizing a project timeline, 4D 

model is the solution to it [3].  

4D model is a 3D model attached to fourth dimension of time via a schedule, 

through the concept of 4D scheduling has been around over 20 years, it has not 

been popular due to some technical challenges associated with it. The continuous 

advancement in technology and emergence of building information modeling 

(BIM) has removed all challenges associated with 4D scheduling. With the 
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increasing success of BIM in the realm of designs, the adoption of 4D modeling is 

becoming the norm today [4]. 

1.2 Research Importance 

         The importance of developing a 4D model and reliable work plan has long 

been recognized by the industry. However, numerous construction projects are 

still plagued by delays and cost overruns, which can frequently be traced to 

ineffective identification and treatment of problems. First, when a construction 

method is not properly identified during scheduling, subsequent problems in the 

field are inevitable. Today’s projects are becoming more and more technically 

complex and logistically challenging, which exposes construction operations to 

even more complex in the way of identification between stakeholders. 

1.3 Problem Statement 

         The traditional scheduling methods, bar charts and Critical Path Method 

(CPM) which are widely used as a planning method, greatly limit our capability in 

modeling and resolving constraints during look-ahead scheduling [5]. 

These methods have long been blamed for their limitations in modeling and 

communicating between stakeholders. Thus, there is a need for a better 

understanding of constraints and conflicts in construction and a structured 

approach in identifying and modeling the schedule to ensure a constraint-free 

work plan, additionally to help a group of non-technical stakeholders visualize the 

scope of design, construction, safety and risk assessment in addition to the phasing 

of the total building program being funded [6]. 

1.4 Research Objectives 

The aim of the current study is to assess the potential impact of adapting 4D modeling 

in the (AEC) industry in Sudan, with this context the objectives of the study were: 
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1. To gauge the level of awareness and understanding of the industry participates 

regarding the BIM and 4D modeling basics. 

2. To determine the extent of use of the relevant software that supports the adapting of 

the concept of “BIM-4D” in the construction industry in Sudan. 

3. To present an exercised model that can overcome the limitations of using traditional 

scheduling methods (bar charts, CPM) and Insure a group of stakeholders visualize the 

scope of design, construction method, safety and risk assessment. 

The result of this study will be valuable to the industry practitioners in developing 

better practice and tools for construction management and look-ahead scheduling. 

1.5 Research Methodology 

The research methodology was two folds; first one a survey of the industry to gauge 

the understanding of the industry participants regarding the BIM & 4D modeling, the 

second fold was application through a real example to prove the potential benefits of 

moving from 2D & 3D scheduling to 4D scheduling. 
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Literature Review 

2.1 Introduction: 

The goals for a construction project will generally reflect the needs and wishes of 

the owner, since most building projects are initiated by an individual, a group of 

persons (company or organization), or a community. It is the task of the project 

team, the group of individuals working on the project, to understand and interpret 

these goals for the owner. The primary goal of all construction project team 

members needs to be project related and to help the owner achieve her or his goals 

and business plan, i.e., to improve education, health care, factory productivity, etc. 

The secondary goals such as improving project quality, increasing construction 

efficiency (in time or cost of the construction), improving project safety, or 

reducing construction risks become team goals that can add value to the project for 

the owner [6]. 

 

The individual and collective goals of project team members need to harmonize, 

and not conflict with the overall owner’s goals; this will require collaboration on 

the part of all team members and enable the ultimate success of the team. 

The use of building information modeling (BIM) as a tool may help in achieving 

the team’s project goals. An interesting characteristic of the BIM process is that it 

tends to make the management process more transparent. The successful use of the 

BIM process will require a different psychological approach than most of the 

building design and construction industry which accustomed to [6]. 

 

The efforts required to implement the building information modeling approach 

successfully will develop directly into its greatest benefits, those of improving the 

four basic concepts of human interaction shown in Figure 2.1. 

This industry will not merely change because of software and technology alone; 

the necessity for change is far more fundamental. All the contributors to the 
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planning, design, and construction of a project have to collaborate and work 

together to be able to produce the desired improvements. 

Figure 2.1 illustrates the basic concepts of human action and interaction: 

visualization, understanding, communication, and collaboration. It is clear that all 

four of these concepts are interactively connected and both generate and reinforce 

one another. 

 

The diagram also suggests, e.g., that the alternative routes to gain understanding 

(of a given subject) can be approached through visualization, communication, or 

collaboration. Each of the four concepts reinforces the other three.  

 

 

 

Figure 2.1: The interrelationship of the four concepts that form the basis for 

human action and interaction. [6] 

2.2 History of project management and planning.  

In 1917, one of the first fathers of project management, Henry Gantt, an American 

mechanical engineer created a scheduling diagram popularly called Gantt chart, 



6 
 

named after him. At that time it was a radical tool, and it became known 

worldwide in the 1920s. The Hoover Dam project, which started in 1931, was 

among the first beneficiaries of the Gantt chart. In fact, even until now. It has long 

been a popular technique for project planning. 

In 1957, the Critical Path Method (CPM) was invented. Developed by the Dupont 

Corporation, CPM is used to estimate project duration and designed to address the 

complex method of shutting down as well as restarting chemical plants due to 

maintenance. The next year, the US Navy Special Projects Office designed PERT 

(Program Evaluation Review Technique) during the cold war. PERT is a method 

for analyzing the tasks involved in completing a project, especially the time 

needed to complete each task and identifying the minimum time needed to 

complete the total project. 

Another milestone happened in 1962, when the United States Department of 

Defense created and mandated the Work Breakdown Structure (WBS) Approach 

for its projects. The WBS was later adopted by private enterprise businesses and 

remains a common project management tool. 

In 1964, the first project management associated in the world, the International 

Project Management Association, was founded in Vienna. At present is has 

120,000 members all over the world. Five years later, the Project Management 

Institute was launched as a nonprofit professional organization for the 

advancement of the profession, science, and practice of project management. 

The rapid evolution and progress of computer technology resulted in the growth of 

some project management software businesses such as Oracle (1977), Artemis 

(1977), and Scitor Corporation (1979). 

The modern history of project management software really took off in the Eighties 

and Nineties, when the information management sectors grew in leaps and bounds, 

especially with the advent of the personal computer and networking facilities. This 
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growth resulted in low-cost PCs that can do multi-tasking and efficiently 

managing complex project schedules. This allowed for the growth of project 

management techniques as well as software programs. 

Examples of big projects done during this rapid growth of information technology 

include the England-France Channel project and the Space Shuttle Challenger 

project. 

The rise of the Internet as well as related online developments led to the explosion 

of radical business practice ideas in the mid-1990s. The Internet has allowed 

people to instantly browse, track, and purchase products and services, resulting in 

making companies more efficient, productive, and client-oriented. Moreover, the 

Internet will be considered a major milestone in the history of project management 

software for allowing many software packages to have an Internet connectivity 

function. 

But after all this methods lacks something to be desired when it comes to 

visualizing a project timeline. 4D model is the solution to it. 4D model is a 3D 

CAD model attached to the fourth dimension of time via a schedule.  

With the information technology and project management evolving more than 

ever, expect the review of history of project management software in the future 

will be marked with even bigger challenges and the demand for increased speed-

to-market when it comes to products and services [7]. 

2.3 History of 2D Drawing and its limitations.  

Numerous standards have evolved with the development of construction drawings 

and specifications over the past few centuries. These two-dimensional (2D) 

drawings and written instructions, which allow a contractor to build what the 

owner, architect, and consultants have visualized, are the current “state of the 

industry.” Nevertheless they can also be the source of great misunderstanding, and 
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most persons involved in building construction will agree that the use of only 

drawings and specifications is an imperfect method of planning and building 

contemporary complex projects. The use of 2D instructions in a 3D world requires 

multiple translations, from the original conceptual visualization in the designer’s 

head to all other persons who need to use, add to, or refine the documents. A 2D 

document (drawing) is used to communicate each exchange of information 

between persons; this 2D communication results in a 3D visualization with each 

transaction, and thus each step requires a translation in someone’s head, until the 

resulting instructions finally need to be visualized correctly by the person 

constructing the project. These transitions between persons may let oversights and 

errors go undetected until it is too late to address them effectively. 

 

Construction is almost always site-specific and rarely performed by the exact same 

project team. These variables complicate the preparations for a project and can 

create substantial challenges for the project team. A certain amount of learning 

needs to take place among the project team to establish working processes that 

take into account the specific project and the personal qualities of its team 

members. The repetitive nature of the information in a drawing set is another 

source of errors. The organization of the drawings for large projects can be 

complex, and as a project develops, it is likely that some of the changes are not 

“picked up” in all places affected in the documents. 

 

Complex projects generally need to be documented by a large team of drafters and 

specifiers; they have the daunting task of visualizing and providing construction 

details for what the designers have in mind, and the builders have to realize. These 

characteristics of documentation are clearly a challenge to the communication 

skills of all the project team members. 
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With the advent of computers, many builders and designers saw their drafting load 

lightened because repetitive tasks could be automated. The essential nature of 

documentation did not change, however; the same drawings and specification 

paragraphs describing the project are still used. A light table (the backlight allows 

several layers of drawings on transparent paper to be overlaid and analyzed) is 

also still the primary tool to analyze interference between various building 

systems, using plan views where height is often difficult to discern. This process 

still leaves much to chance because it is a challenge to visualize the coordination 

properly, without the ability to verify it prior to the actual construction. Most 

construction projects thus have a large quantity of Requests for Information (RFIs) 

about the documents and a substantial amount of rework before all building 

components are coordinated during the actual construction. 

 

It is difficult with a traditional construction documentation set to completely and 

accurately represent many of the complex structures built today. 

In 2D drawings it is often the transitions between elements that are difficult to 

represent and easy to forget to design and document. An example is the transition 

between different cladding systems, particularly where special attention needs to 

be given to waterproofing. 

It is often easy to imagine a project is represented completely without knowing 

what has been neglected, until the builder is ready to assemble it [1]. 

 

2.4- 4D Modeling 

Though the concept of 4D scheduling has been around over 28 years, it has not 

been popular due to some technical challenges associated with it. The continuous 

advancement in technology and the emergence of Building Information Modeling 

(BIM) have removed all challenges associated with 4D scheduling. With the 
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increasing success of BIM in the realm of designs, the adoption of 4D modeling is 

becoming the norm today. 

 

2.4.1- 4D Modeling Offers Significant Benefits over 3D Modeling:  

4D model is a further development over 3D model. It challenges and changes 

many of the practices of conventional scheduling [8]. Some of the significant 

considerations are as follows: 

 

 Visualization of the Project: 4D model enables the scheduler to view the 

entire construction site in a nutshell. The scheduler is able to move around, 

look outside, inside and under the building and verify the progress of project. It 

helps the scheduler to detect inconsistency and avoid visual incongruities in the 

representation. 

 Better Integration and Cost Estimation:  

Integrating human resources, equipment and material resources with the BIM 

model, 4D scheduling helps to better schedule and cost estimate of the project. 

4D BIM also monitors procurement status of project materials.  

 Conflict Detection and Resolution:  During design and construction phase, 

potential spatial conflicts may arise between building components. It is not 

easy to identify or predict these conflicts using 2D or 3D layouts, but 4D model 

identifies various issues related to space, schedule and sequencing, and resolve 

them ahead of the construction process. 

 Improved Time Management:  Integrated with BIM modeling, 4D 

scheduling helps the owner as well as project team to easily visualize time 

constraints and opportunities of improvement and investment in the project. 

 Maximization of Critical Resources: 4D model allows the project team to 

evaluate various alternatives resources and scopes of work over a period of 

time to optimize the resources and labor accordingly. 

 

http://www.architecturalevangelist.com/building-information-modeling/bim-implementation-problems-prospects-and-strategies.html
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2.4.2- 4D Project Planning with BIM 

By adding the schedule date to the model components, project team improves the 

plan and integrates the communication among various divisions. With the progress 

of time, project team programmatically links schedule to BIM model to evaluate 

various construction options to make the optimum decision. 

2.5 BIM planning  

BIM project planning is based on fundamental BIM concepts and includes [9] 

1. Determining the purpose for the BIM (set project and process goals). 

 

2. Developing BIM specifications (choose processes, tools, and milestones for the 

work). 

3. Developing implementation plan for the process (develop process strategies, 

select the team, and develop evaluation and adjustment methods). 

The planning of a building information model is the preparation for the 

implementation of the BIM process.  

The fundamental questions at this stage are as follows: 

• What is the nature of the project? 

• What is the nature of the project delivery method? 

• What are the anticipated benefits of the simulation? 

• What are the most critical anticipated difficulties (both project- and process-

related)? 

It is important to be explicit in defining all anticipated aspects of the project 

development, and to establish controls and methods for evaluating the results of 

the process. 

The answers to these questions will become the basis for the specifications of the 

simulation; this is a critical and often underestimated aspect of this process! 
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It is tempting to focus on the more object-oriented (3D model), rather than the 

process oriented, aspects of the BIM specifications, even though it is ultimately 

the process that determines the requirements (characteristics) of the model objects. 

For example, if the exact size and location of concrete slab pours in a construction 

sequence is being studied, the slab sections will need to be modeled exactly as 

they are anticipated for the concrete pours, so that they can be properly 

represented in the construction sequence. This may require close collaboration 

between the modeler and the construction superintendent, and it could take several 

modeling sessions to optimize the pour sequence for the slab. If a cost estimate is 

desired, a deliberate choice of model components will have to be planned (with 

the appropriate level of detail) to represent the project in the cost estimate. In other 

words, it is more important to establish the various processes that need to be 

addressed first, before becoming distracted with the actual modeling itself. 

The planning discussion is divided into three parts: first, the analysis of the 

purpose of the BIM, next, the development of the specifications required to 

achieve the desired results, and finally the implementation plan for the steps that 

are necessary to meet the chosen specifications [10]. 
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Research Methodology 

3.1 General:  

The research methodology was two folds; first one a survey of the industry to 

gauge the understanding of the industry participants regarding the BIM & 4D 

modeling, the second fold was application through a real example to prove the 

potential benefits of moving from 2D & 3D scheduling to 4D scheduling. 

There are various software programs dealing with BIM-4D concept like (Asta 

power project, Ceapoint, Synchro, Vico, Navisworks, etc.) the current study 

represent Navisworks manage as a tool of BIM-4D concept.  

3.2 Research Contents:  

A simple yet informative questionnaire was designed to be used as the main tool 

for data collection in the first part of the research. It comprised three parts: first 

part was general information about the participates, second part was general 

concept of BIM, and the third part was usage of (BIM) fourth dimension technique 

in construction projects at Sudan. 

Questions were meant to be closed with a four point likest scale for respondent’s 

feedback. The targeted participants included all the parties involved in the project  

(A copy of the questionnaire is attached in appendix 2). 

3.3 Sample Distribution:  

After distribution and collection processes the returned questionnaires were 44 

questionnaires by using Google Forms. The analysis and illustration the results of 

the data which was collected from the questionnaires, was done by using Google 

Forms also. 
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3.4 Autodesk Navisworks:  

 Over the years, the Navisworks interface has remained relatively unchanged until 

the 2011 release [11].  

Autodesk introduced a new interface based on tabs and panels, all the while 

keeping some of the features from the previous versions. 

With the Navisworks 2013 release, new tools have been added to take advantage 

of the native Revit files, Grid tools, and a new interface for the Clash Detective. 

3.5 functions and tools of Navisworks [11]: 

Navisworks software gives multi functions beside Adding fourth dimension (scope 

of study in this thesis) to the 3D model. 

 

1.  4D Scheduling:  

Simulate construction schedules and logistics in 4D to visually communicate and 

analyze project activities, and help reduce delays and sequencing problems. 

 

The 4D scheduling features enable you to verify building or demolition viability 

by developing construction or demolition sequences that link model geometry to 

times and dates; import times, dates, and other task data from project management 

software to dynamically link schedules with project models; and set up planned 

and actual times to visualize deviations from the project schedule. 
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Figure 3.1: Simulate construction schedules.[11] 

 

2. Collaboration Toolkit: 

Communicate design intent and encourage teamwork with the ability to add 

markups to viewpoints with advanced redlining tools, comment on viewpoints 

with searchable notes, record animated walkthrough for real time playback, and 

stream large models and content, navigating the design as the model loads. 

3. Clash and Interference Management: 

Autodesk Navisworks Manage software provides the ability to manage and track 

clashes and interferences through to resolution. Reports of clash tests, including 

comments and screenshots, can be exported to communicate issues to the project 

team. 

4. Clash and Interference Detection: 

Anticipate and avoid potential problems before construction, reducing expensive 

delays and rework. Clash and interference detection features in Autodesk 

Navisworks Manage software enable user to perform clash tests against specified 

geometry to more easily find and resolve conflicts. Link clash tests to 4D 

simulations and object animations to analyze issues in space and time. 
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Figure 3.2: Clash Detection [11] 

 

5. Object Animation: 

The software’s object animation features help you create animations of objects for 

clash and interference analysis. You can create interaction scripts that link 

animations to specific events, triggers, or key comments, and link animations to 

tasks in a 4D schedule for improved construction planning. 

6. Photorealistic Visualization: 

Use Autodesk Navisworks advanced visualization features to develop compelling 

3D animations and imagery to present projects to stakeholders. Customize and 

configure every render aspect, including materials, lights, backgrounds, and 

rendering styles; use environment backgrounds to add real-world scenery; and 

choose from more than 1,000 built-in materials to create an accurate, 

photorealistic look. 
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Figure 3.3: Photorealistic visualization.[11] 

 

7. Real Time Navigation: 

Explore your integrated project model using advanced navigation tools that 

produce a realistic, real-time experience. Real-time navigation capabilities are 

included in all Autodesk Navisworks products. 

8. Quantification: (from version Navisworks 2014) 

Users can automatically make material estimates, labors cost plus indirect cost of 

projects estimate, measure areas and count building components. 

 

3.6 The Products of Navisworks software: 

The Autodesk Navisworks software family offers three products to provide project 

stakeholders with the right tools to help collaborate, coordinate, and communicate 

more effectively. Table 3.1 reviews the deference between three types. 

 Autodesk Navisworks Manage: 

Autodesk Navisworks Manage software is a comprehensive review solution for 

analysis, simulation, and coordination of project information. Multidisciplinary 

design data can be combined into a single integrated project model for interference 

management and clash detection. 
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Navisworks Manage helps design and construction professionals anticipate and 

avoid potential problems before construction. This is type of Navisworks software 

family chosen to be used in this research. 

 Autodesk Navisworks Simulate: 

Autodesk Navisworks Simulate software provides advanced tools for reviewing, 

analysis, simulation, and coordination of project information. Comprehensive 4D 

simulation, animation and photorealism capabilities enable the demonstration of 

design intent and simulation of construction to provide better insight and 

predictability. Real-time navigation combines with review toolsets to support 

collaboration among the project team. 

 Autodesk Navisworks Freedom: 

Autodesk Navisworks Freedom software is the free viewer for NWD and 3D 

DWF files. Navisworks Freedom extends the whole project view to all project 

stakeholders, helping to improve communication and collaboration. 

 

Table (3.1): Deference between three products of Navisworks.[11] 

 

 

3.7 Navisworks file formats: 

There are three types of Navisworks file formats: 

 NWC: Exported files from CAD to Navisworks always saved as NWC, and 

NWC files are typically smaller than their original files. 
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 NWF: When we adding the time schedule to the model in Navisworks the new 

file saved as NWF file. 

 NWD: This file content the geometry model with review markups, his space is 

larger than other files, separated from other files or original models and we can 

give it a password and specific period the file will not open after this period.   

 

3.8 General features of Autodesk Navisworks: 

(The source of all figures in section 3.7 from Navisworks manage 2014 software) 

The land scape of Navisworks similar to other Autodesk software’s land scape and 

this will be familiar with users those using some of Autodesk software’s products. 

See figure 3.4. 

 

Figure 3.4: landscape of Navisworks Manage. 

 Application Menu: (The green N) 

A basic starting point within Navisworks, the Application menu, or green N, 

contains operations like New, Open, and Save. Several other useful operations that 

can be performed from here are shown in Figure 3.5. 
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Figure 3.5: The green N, or Application menu 

 

To preview the lists that included in "application menu" and there functions                  

see appendix 1. 

 Quick Access Toolbar: 

The Quick Access toolbar, located adjacent to the Application menu, is a series of 

predefined operations. By default, you can find New, Open, Append, Merge, Save, 

Print, Refresh, Undo, and Redo. 

The Quick Access toolbar is customizable. You can remove tools by right-clicking 

the item you wish to remove or by 

clicking the down arrow to the right of 

the bar and clicking the option you wish to remove. You can add tools by selecting 

them from the tab and panel locations, right clicking, and then choosing Add to 

Quick Access Toolbar. 

 Tooltip: 

If you pause and hover your mouse cursor over any area in Navisworks, you get a 

tooltip, as shown here. Tooltips briefly explain the tool and may contain 
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information about shortcuts (such as pressing Ctrl+ A for Append). Also, if you 

leave your mouse in place a little longer, you will gain a longer explanation of the 

tool, the tooltip will expand into a definition from the help file. 

 

Figure 3.6 Tooltip 

 

 Navisworks Options: 

 

Options, or the Options Editor (sometimes referred to as Global Options), is used 

to adjust the program settings for Navisworks. The settings that you change here 

are retained across different Navisworks sessions. Settings can also be shared 

across a project team via the import/export feature (Figure 3.7). 

 

Figure 3.7 Options Editor 
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To preview the lists that included in "options editor" and there functions see    

appendix 1. 

 

 Exploring the Ribbon: 

The ribbon, located at the top of the user interface, is a palette that groups the 

entire Navisworks toolset into an easy to find and use location. The ribbon is 

divided into tabs, with each tab supporting a specific activity or task. Within each 

tab is a series of panels that contain the available tools. 

While you are not able to add to or remove custom commands from the ribbon, 

you can customize the appearance and location of the panels using these methods: 

 Right-click the tab or panel to open the context menu. From here, you can turn 

tabs or panels on or off. 

 Left-click and hold a specific panel to move its location. You can change its 

location to a new place within the tab or drag it out into the workspace to make 

it more accessible. Panels may not be moved to other tabs. 

 To reset the panel to its default position, right-click on an empty location on the 

panel and click Restore Default Ribbon. 

 

Pushpins:  

Any time a pushpin icon appears, you can click it to pin an item to the screen. This 

will allow the panel or palette to stay on top and remain open as you move to other 

tools in Navisworks. 

Home: 

 The Home tab contains Project, Select & Search, Visibility, Display, and Tools 

panels (Figure 3.8 and Figure 3.9).  
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Figure 3.8 Home tab, showing additional tools enabled 

To preview the panels that included in "Home" tab and there functions see 

appendix1. 

 

Figure 3.9 Home tab continued 

Viewpoint:  

The Viewpoint tab contains the Save, Load & Playback panel as well as the 

Camera, Navigate, Render Style, Sectioning, and Export panels (Figure 3.10 and 

Figure 3.11). 

To preview the panels that included in "Home" tab and there functions see 

appendix1. 

 

 

Figure 3.10 Viewpoint tab 
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Figure 3.11 Viewpoint tab continued 

 

Review:  

The Review tab contains Measure, Redline, Tags, Comments, and Collaborate 

panels (Figure 3.12). 

To preview the panels that included in "Review" tab and there functions see    

appendix 1. 

 

 

Figure 3.12 Review tab 

 

Animation: 

This tab contains the Create, Playback, Script, and Export panels (Figure 3.13). 

 

Figure 3.13 Animation tab 

To preview the panels that included in "Animation" tab and there functions see 

appendix 1. 
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View:  

The View tab contains Stereo, Navigation Aids, Grids & Levels, Scene View, and 

Workspace panels (Figure 3.14). 

 

 

Figure 3.14 View tab 

To preview the panels that included in "View" tab and there functions see 

appendix 1. 

 

Output: 

The Output tab contains Print, Send, Publish, Export Scene, Visuals, and Export 

Data panels (Figure 3.15 and Figure 3.16). 

 

 

Figure 3.15 Output tab 

 

 

Figure 3.16 Output tab continued 
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To preview the panels that included in "Output" tab and there functions see 

appendix1. 

 

 Status Bar, Performance Indicators, and Context Menus: 

Located in the bottom-right corner of the screen is the status bar, which contains 

four performance indicators that give you feedback on the performance of your 

computer and currently loaded Navisworks model (Figure 3.17). 

 

Figure 3.17 Status bar 

Pencil Bar: Indicates how much of the current view is drawn, that is, how much 

image dropout there is in the current view. When the progress bar is at 100 

percent, the scene is completely drawn, with no dropout. The icon changes color 

when a redraw is in progress. While the scene is being drawn, the pencil changes 

to yellow. If there is too much data to handle and your computer cannot process 

this quickly enough for Navisworks, then the pencil changes to red, indicating 

dropout. 

 

Disk Bar: Indicates how much of the current model is loaded from the local hard 

drive. When the progress bar is at 100 percent, the entire model, including 

geometry and property information, is loaded into memory. The icon changes 

color when a file load is in progress. While the data is being read, the disk changes 

to yellow. If there is too much data to handle and your machine cannot process it 

quickly enough for Navisworks, then the disk changes to red, indicating a 

potential problem. 

 

Web Server Bar: Indicates how much of the current model is downloaded from a 

web server. When the progress bar is at 100 percent, the entire model has been 

downloaded. The icon changes color when a file load is in progress. While data is 
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being downloaded, the web server changes to yellow. If there is too much data to 

handle and your computer cannot process it quickly enough for Navisworks, then 

the web server changes to red, indicating a potential problem. 

 

Memory Bar: Indicates the amount of system memory being utilized by 

Navisworks. 

Navisworks uses a few context menus that contain various tools. These tools can 

help you save time once you master when and how to leverage them. 

 

No Item Selected: This context menu (Figure 3.18) has a variety of tools that are 

found across various tabs and toolbars within Navisworks but that have been 

centralized for easy access. Access this menu by right-clicking in white space 

away from geometry. Once the menu is open, select your tool. 

 

Figure 3.18 Context menu, with no items selected 

 

With Item Selected: The With Item Selected context menu contains even more 

tools to help you along your way. Access this menu (Figure 3.19) by right-clicking 

once you’ve selected the geometry. If you right-click when no geometry is 

selected (right-clicking on the object instead of selecting it first), Navisworks will 

select that single piece of geometry and open this context menu as well, saving 

you the step of having to select the object first. 
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Figure 3.19 Context menu, with an item selected 

 

 The Bottom Line: 

Understand the ribbon: Knowing the locations of various tools within the 

Ribbon provides a good foundation for being able to quickly access items across 

the Navisworks interface. 

 

Use the Measure and Redline tools: The Measure and Redline tools are useful in 

Navisworks throughout a project and having a basic understanding of these tools 

is essential. 
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3.9 Illustration on how to develop a 4D Model: 

3.9.1 General information about the model: 

The exercised model used for application was a simple tall building consists of 11 

floors plus roof.  Skeleton contains a flat slabs (18*30) m
2
, circular columns, stairs 

and shear walls.  

The roof deviates from suspended slab by 34.55 degree (2.88 degree for each floor). 

The module covered from outside by glasses and plastic cladding. 

This research focusing on connecting between 3D model exported from Rivet 

software and schedule of construct this building to explain the procedure to doing 

that in Navisworks software. Refer to figure 3.20 

 

 

Figure 3.20 Three dimension model in Revit 

 

- The source of figure from Revit 2014 software. 
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3.9.2 Transport the Model: 

 Export the Model from Revit software: 

From “Add-In’s” tab in Revit software go to “External” panel and choose from 

external tools (Navisworks 2014) or any other version. 

 

Figure 3.21 Exporting Model from Revit to Navisworks 

(The source of figure from Revit 2014 software) 

 

      -   Make sure to save the file as Navisworks (NWC) type  

      -   Choose “Navisworks setting” to be sure the exporting will be for all model 

not only the interface and that by choosing from “Export”           Entire Project.  

 

 Import the 3D model to Navisworks software: 

To Import the model in Navisworks software, From Application Button, go to 

Open and choose the naviswork file that was exported from Revit software. 
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Figure 3.22 Importing Model to Navisworks 

 

 

 Figure 3.23 The imported Model in Navisworks interface
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3.9.3 Identifying, grouping and sorting the model’s elements: 

In order to link between the 3D imported model and schedule tasks to make the 

simulation, you have to identify any group of components that shearing one task or 

activity in schedule. 

For example if you have  an activity named by “Construct the pile foundation”  and 

you want to link this task with the structural 3D model, you must select the elements 

in model like piles and piles cap to set it as one group in set list, to attach between 

them in the simulation. 

1. Selection Tree: 

The selection tree is a window, which displays a variety of hierarchical views of the 

structure of the model, as defined by the CAD application in which the model was 

created.   

To open the selection tree, From Home tab, go to Select & search panel and choose 

Selection Tree.   

 

Figure 3.24 Selection tree for the exercised mode
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Autodesk Navisworks uses this hierarchical structure to identify object-specific 

paths (from the file name down to a particular object). 

Naming of items reflects the name from original CAD application wherever 

possible. 

By default there are four options on the drop-down list:  

 • Standard: Displays the default tree hierarchy, including all instancing. The 

hierarchy can be sorted alphabetically.  

• Compact: Displays a simplified version of the hierarchy on the Standard option, 

omitting various items. You can customize the level of complexity of this tree in the 

Options Editor.  

• Properties: Displays the hierarchy based on the items' properties. This enables 

simple manual searching of the model by item property.  

• Sets: Displays a list of selection and search sets. If no selection and search sets 

have been created, this option is not shown.  

Note: The list of the items on the Sets option is exactly the same as the list on the 

Sets window. 

2. Sets: 

From the Sets window you can add, move and delete selection and search sets, and 

organize them into folders.   

To open the Sets window, From Home tab, go to Select & search panel and choose 

Sets.  

Search and selection sets can be updated. You can modify your current selection in 

the 
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Scene View or the current search criteria, and change the contents of your set to 

reflect 

this. You can drag and drop items from the Scene View and the Selection Tree into 

the Sets window to create new selection sets.  

 

Figure 3.25 Sets window for the exercised mode 

After arrange the elements for all building in Sets window, now you will be able to 

link between the elements in sets list with the opposite tasks in the project using 

time liner tool. 

3.9.4 Project schedule: 

You can make the project schedule in Navisworks or importing ready one from 

other scheduling software, for example Ms-project or primavera. 

 

To make the project schedule in Navisworks use the tool of Timeliner. 



35 
 

 Time liner window:  

The Time Liner window enables you to attach items in the model to project tasks, 

and simulate project schedules. 

To open Time liner window, From Home tab, go to Tools panel and choose Time 

liner.  

 

There are four tabs in time liner window (Tasks, Data Sources, Configure and 

Simulate) 

1. Tasks Tab: 

The Tasks tab enables you to create and manage project tasks. It shows all of the 

tasks in your schedule, listed in a table format. You can use the scroll bars at the 

right and at the bottom of the tab to move through the task records. 

 

Figure 3.26 Tasks table window for the exercised model. 

To preview the tabs that included in "Tasks" tab and there functions see appendix 1. 
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2. Data Sources: 

The Data Sources tab enables you to import tasks from a third-party scheduling 

software, such as Microsoft Project, Asta, and Primavera. It shows all added data 

sources, listed in a table format. 

 

Figure 3.27 Data resource window for the exercised model. 

The data sources are shown in a multi-column table. The columns show name, 

source (for example, Microsoft Project) and project (e.g. my_schedule.mpp). Any 

further columns (there may be none) identify the fields from the external schedule 

which specify the task type, unique id, start date and end date for each imported 

task.  

You can move and resize columns, if necessary. 

To preview the tabs that included in "Data Sources" tab and there functions see 

appendix 1. 

3. Configure: The Configure tab allows you to set up the task parameters, such as 

task types, appearance definitions for tasks, and the default model appearance at the 

start of the simulation. 
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TimeLiner comes with three predefined task types:  

 • Construct: for tasks where the attached items are to be constructed. By default, 

during a simulation, the objects are highlighted in green at the start of the task and 

are reset to Model Appearance at the end of the task.  

• Demolish: for tasks where the attached items are to be demolished. By default, 

during a simulation, the objects are highlighted in red at the start of the task and are 

hidden at the end of the task.  

• Temporary: for tasks where the attached items are only temporary. By default, 

during a simulation, the objects are highlighted in yellow at the start of the task and 

are hidden at the end of the task. 

 

Figure 3.28 Configure window for the exercised model. 

To preview detailed functions included in "Data Sources" tab see appendix 1. 

4. Simulate tab: The Simulate tab enables you to simulate your Time Liner 

sequence throughout the duration of the project schedule.  
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Figure 3.29 Simulate window for the exercised model. 

To preview detailed functions included in “Simulate tab  “ tab see appendix 1. 

 

3.9.5 Simulate the 4D model: 

After you complete the scheduling and the attaching between the sets of elements 

with their opposite tasks you can make the simulation using same last tool “time 

liner” by the last fourth tab “simulate”. 

Simulation Settings Dialog Box:  

The Settings button on the Simulate tab provides access to the Simulation Settings 

dialog box.  

file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-E296880A-1607-4755-9A99-D92ECD43463E.htm
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Figure 3.30 Simulation settings window 
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The final output from this process is simulation of construction processes sequence 

during the construction period  

 

 

 

Figure 3.31 Simulation to construction processes 
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Results analysis and Discussion 

4.1 Introduction: 

This study is to examine the range of spreading in using software which supports 

the concept of “BIM-4D” in construction industry at Sudan and level of awareness 

among projects management stakeholders by role of applying 4D model in control 

the delaying and cost over runs in projects. 

After distribution and collection processes the returned questionnaires were 44 

questionnaires by using Google Forms. The analysis and illustration the results of 

the data which was collected from the questionnaires, was done by using Google 

Forms also. 

4.2 Sample configuration: 

A sample with size 44 respondents was randomly selected; it comprised 

participants with different education level as presented in table 4.1 and figure 4.1 

Table 4.1 Respondent’s education level 

 Frequency Percent % 

Diploma 4 9.1 

Bachelor 52 56.8 

Master 31 29.5 

Doctorate 5 4.6 

Total 44 100 
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Figure 4.1 Respondent’s education level 

The presented results show that the above majority (56.8%) was Bachelor's degree 

then Master's degree (29.5%) which consider good indicator for targeted age from 

the selected sample. 

Regarding their area of work, the sample was distributed in two main layers; Civil 

engineers representing (88.6%) of the sample, and Architecture engineers (11.4%). 

(Refer to table 4.2 and figure 4.2) 

Table 4.2 Respondent’s area of work 

 Frequency Percent % 

Civil Engineer 39 88.6 

Architect 5 11.4 

Others 0 0 

Total 44 100 
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 Figure 4.2 Respondent’s specialties. 

When asked to identify their position in their organizations, respondents were 

found to be distributed as directors (20.5%) while about a third (31.8%) were 

technical officers, (36.4%) were site engineers and (11.3%) were other positions. 

this results is matching with their experience ages.  

(Refer to table 4.3 and figure 4.3) 

Table 4.3 Respondent’s position 
 Frequency Percent % 

Director 9 20.5 

Technical Office 14 31.8 

Site Engineer 36 36.4 

Other 5 11.3 

Total 44 100 
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Figure 4.3 Respondent’s position 

 

A substantial majority (79.5%) of these participating was belong to Public sector, 

refer to table 4.4 and figure 4.4 

 

Table 4.4 Sectors where respondent work for 
 Frequency Percent % 

Public 35 79.5 

Private 9 20.5 

Total 44 100 
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Figure 4.4 Sectors where respondent work for 

 

With respect to their experience (54.5%) showed that their experience is almost 

less than 5 years, about a third (31.5%) have an experience from 6 to 10 years and 

for the remaining sample (14%) have more than 11 years of experience (refer to 

table 4.5 and figure 4.5).  

 

Table 4.5 Respondent’s years of experience 
 Frequency Percent % 

0-5 years 24 54.5 

6-10 years 14 31.5 

11-15 years 5 11.4 

More than 15 years 1 2.6 

Total 44 100 
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Figure 4.5 Respondent’s years of experience 

 

It thought that those who had the chance to practice abroad would have dealt with 

BIM concept in their works. Consequently, a question was included to check 

whether the respondents work abroad. The feedback presented in table 4.6 and 

figure 4.6 showed that above 2/3 (61.4%) of the respondent did not worked abroad, 

while a third were did it.   

Table 4.6 Respondent’s work in other countries except Sudan 

 Frequency Percent % 

Yes 17 38.6 

No 27 61.4 

Total 44 100 
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Figure 4.6 Respondent’s work in other countries except Sudan 

 

4.2.1 General concepts on Building Information Technology (BIM)  

 

The main objective for this section is to gauge the level of awareness and 

understanding of the industry participates regarding the BIM basics. 

 

Regarding the familiarity with concept of BIM (25%) showed that the respondents 

had a weak familiarity with BIM concept and (38.6%) had medium level (refer to 

table 4.7 and figure 4.7), so the results show that the above majority (68.6%) had a 

lack of Familiarity with BIM knowledge in Sudan. 

Table 4.7 Level of Respondent’s Familiarity with concept of BIM 

 Frequency Percent % 

Weak 11 25 

Medium 17 38.6 

Good 8 18.2 

Very Good 6 13.6 

Excellent 2 4.6 

Total 44 100 
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Figure 4.7 Level of Respondent’s Familiarity with concept of BIM 

 

A substantial majority (68.2%) of these respondents as showed in table 4.8 and  

figure 4.8 did not apply the BIM techniques in their works, so this is also indicator 

for weak spreading of BIM techniques in Sudan.  

 

Table 4.8 Respondents whom applied the BIM techniques in their works 

 Frequency Percent % 

Yes 14 31.8 

No 30 68.2 

Total 44 100 

 

 



49 
 

 

Figure 4.8 Respondents whom applied the BIM techniques in there works 

Regarding their experience in applying BIM techniques, the weight average of the 

results showed in table 4.9 and figure 4.9 was “Medium”. This is also underscores 

the fact that applying of BIM techniques is weak in Sudan. 

 

Table 4.9 Level of respondent’s experienced about applying BIM techniques in 

construction projects. 

 Frequency Percent % 

Weak 15 34.1 

Medium 15 34.1 

Good 7 15.9 

Very Good 5 11.4 

Excellent 2 4.5 

Total 44 100 
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Figure 4.9 Level of respondents experienced about applying BIM techniques in 

construction projects. 

In order to gauge the acceptability of respondents to BIM techniques a question 

was included, the results in table 4.10 and figure 4.10 showed that the weight 

average of results was “very good” to “Excellent”. 

Table 4.10 Level of respondent’s interesting for knowing about BIM techniques in 

their works. 

 Frequency Percent % 

Weak 2 4.2 

Medium 1 2.7 

Good 7 15.9 

Very Good 10 22.7 

Excellent 24 54.5 

Total 44 100 
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Figure 4.10 Level of respondent’s interesting for knowing about BIM techniques in 

their works. 

When asked the respondent about their opinion in importance and value of 

implementation the BIM’s software in construction projects in Sudan, (50%) were 

strongly agreed with the concept, which is good indicator to acceptance of this 

technology. 

(Refer to table 4.11 and figure 4.11) 

Table 4.11 Respondent’s opinion about importance and value of implementation 

the BIM’s software in construction projects in Sudan. 

 Frequency Percent % 

Strongly Agree 22 50 

Agree 14 31.8 

Likely 6 13.6 

Disagree 2 4.6 

Total 44 100 
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Figure 4.11 Respondent’s opinion about importance and value of implementation 

the BIM’s software in construction projects at Sudan. 

 

4.2.2 Usage of (BIM) fourth dimension technique in construction projects in 

Sudan. 

 

The main objective for this section is to gauge the level of understanding and usage 

of BIM fourth dimension technique in the construction industry in Sudan. 

 

Table 4.12 Represent the respondent’s opinion about the high level administrations 

in companies that working in AEC industry in Sudan accept the concept of 

applying BIM in their projects. 

 Frequency Percent % 

Strongly Agree 2 4.5 

Agree 14 31.8 

Likely 19 43.2 

Disagree 9 20.5 

Total 44 100 

The above Table 4.12 and the following Figure 4.12 present Respondent’s opinion 

about whether the high level administrations in companies that working in AEC 
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industry accept the concept of applying BIM in their projects,the Weight average 

was conducted to the results and was going to “Agree” as shown in figure 4.17  

 

Figure 4.12 represent the respondent’s opinion about the high level administrations 

in companies that working in AEC industry in Sudan accept the concept of 

applying BIM in their projects. 

 

Table 4.13 Represent the respondent’s opinion about the concept “the output from 

connection between the 3D model and schedule of the projects is simulation of 

construction scenario and its enhancing sharing knowledge between stakeholders” 

 Frequency Percent % 

Strongly Agree 21 47.7 

Agree 20 45.5 

Likely 3 6.8 

Disagree 0 0 

Total 44 100 

Regarding the respondent’s opinion about the concept “the output from connection 

between the 3D model and schedule of the projects is simulation of construction 

scenario and its enhancing sharing knowledge between stakeholders”, (47.7%) 

were strongly agreed the concept (refer to above table 4.13 and the following 

Figure 4.13) the weight average of Respondent’s opinion was 1.6 going to “Agree” 

as shown in figure 4.17 
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Figure 4.13 represent the respondent’s opinion about the concept “the output from 

connection between the 3D model and schedule of the projects is simulation of 

construction scenario and its enhancing sharing knowledge between stakeholders” 

To knowing which of BIM’s Software used in construction market in Sudan a 

question was conducted, table 4.14 represent the answers and it is proof  that the 

widely spreading of using “Revit & Primavera” software instead of other BIM’s 

software in Sudan. 

Table 4.14 Represent the respondent’s chooses of which type of software that 

supports BIM-4D concept are used in their projects (multiple chosen was available) 

Software Frequency 

Revit 29 

Robot 8 

AutoCAD 19 

MS project 12 

Navisworks 6 

Primavera P6 28 

Archicad 2 

 



55 
 

When asked the respondents about the concept “BIM-4D contributes by effectively 

manner in monitoring and controlling the cost and time of projects” (52.3%) agreed 

with the concept (see table 4.15 and figure 4.14) addition to that the weight average 

of Respondent’s opinion was done and also its going to “Agree” as shown in figure 

4.17, so it’s good indicator for actuality of this concept. 

Table 4.15 Represent the respondent’s opinion about the concept “BIM-4D 

contributes by effectively manner in monitoring and controlling the cost and time 

of projects” 

 Frequency Percent % 

Deeply Agree 18 40.9 

Agree 23 52.3 

Likely 2 4.5 

Disagree 1 2.3 

Total 44 100 

 

 

Figure 4.14 represent the respondent’s opinion about the concept “BIM-4D 

contributes by effectively manner in monitoring and controlling the cost and time 

of projects” 
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Finally when asked the participants about the concept “BIM-4D contributes in risk 

assessment processes during planning phase and decreasing the chances of 

happening during executing phase” (59.1%) voted by agreed for this concept (see 

table 4.16 and figure 4.15) also the weight average of Respondent’s opinion was 

going to “Agree” as shown in figure 4.17, also it’s good indicator for actuality of 

this concept. 

Table 4.16 Represent the respondent’s opinion about the concept “BIM-4D 

contributes in risk assessment processes during planning phase and decreasing the 

chances of happening during executing phase” 

 Frequency Percent % 

Deeply Agree 11 25 

Agree 26 59.1 

Likely 6 13.6 

Disagree 1 2.3 

Total 44 100 

 

 

 

Figure 4.15 represent the respondent’s opinion about the concept “BIM-4D 

contributes in risk assessment processes during planning phase and decreasing the 

chances of happening during executing phase” 
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Figure 4.16 represent the weight average to respondent’s opinion about part three 

questions 

 

The above figure present the weights average for most important concepts in 

questionnaire, and the Major concept that the respondents was deeply agreed with 

it was “the output from connection between the 3D model and schedule of the 

projects is simulation of construction scenario and its enhancing sharing knowledge 

between stakeholders”  
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Conclusions and Recommendations 

5.1 Preamble 

This chapter will summarize the output from this research regarding BIM-4D 

concept and the effectiveness of using software which support this concept. 

“Navisworks manage 2014” was used as software where a simple case was 

presented and scheduled to illustrate the modeling process and the application for 

this research. Furthermore, present the conclusion of questionnaire results.  

5.2 Conclusions 

1- BIM-4D contributes by effectively manner in monitoring and controlling the 

cost and time of projects, and such it could be considered as a useful tool for 

project managers.  

2- BIM-4D helps in risk assessment processes during the planning phase and as 

such it contributes to decreasing the chances of problems occurrence during the 

execution phase. 

3- Navisworks software is considered a very good software, because it is connected 

to a number of same popular and commonly used software among Sudanese 

engineers. 

4- Generally the spread of BIM concept is still weak among the engineers in the 

construction industry in Sudan, but conversely there is strong orientation from new 

graduate engineers and those have a medium level of experience (from 5 to 10 

years) so this is a good indicator for future of this technology in Sudan. 

 

5- The practical sample of 4D model provides the basis for a common language 

between all parties and a representation of the project schedule and component of 

construction model. 
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5.3 Recommendations 

1- Increase the level of awareness of the projects participates by introducing 

regulations that necessitate the use of software and relevant packages in all the 

project stages. 

 

2- Compulsion of contractors gradually to submit 4D- model with project’s 

execution plan documents as a tool of quality assurance to insure the realistic of 

planned schedule and matching with the real construction processes. 

 

3- Increase the researches and published papers in this topic with considering the 

nature of AEC industry in Sudan. 

 

4- Educate the student at universities this is software to follow the growth of 

technologies in this discipline.     

 

5.4 Proposed Future Studies 

 

1- Building information modeling globally is new technology so it is necessary to 

concentration researches in this discipline. 

2- To widen this research by considering the other three dimensions, fifth, sixth and 

seventh dimension (cost, integration BIM, operation) 

3- To farther investigate the capabilities and functions of Navisworks as a useful 

software. 
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Appendix 1 

Represent to know Autodesk Navisworks: 

The land scape of Navisworks similar to other Autodesk software’s land scape and 

this will be familiar with users those using some of Autodesk software’s products. 

See figure 1. 

 

Figure 1: landscape of Navisworks Manage. 

 Application Menu: (The green N) 

A basic starting point within Navisworks, the Application menu, or green N, 

contains operations like New, Open, and Save. Several other useful operations that 

can be performed from here are shown in Figure 2. 
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Figure 2: The green N, or Application menu 

 

New: Closes the currently open file and opens a new file. 

Open: Opens a new file (see Figure 3). Note that using Open while another file is 

already open will close that currently open file. You want to use Append and 

Merge to add additional files. Options include:  

Open: Opens a new file while closing the currently open file. 

Open URL: Opens a file from a URL, usually a website location. 

Append: Appends additional files into already open files and merges duplicate 

geometry. 

Merge: Merges a selected file into other files and adds only new information such 

as new geometry, new viewpoints, and new clashes. 
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Figure 3 Additional Open operations 

 

Save: Saves the current file. 

Save As: Allows you to save the file in a different location or as a different file 

type (for example, as an NWD or NWF file). It allows you to save up to three 

versions back. 

Export: Contains the Export operations (see Figure 4). Many of the other 

operations are located on the Output tab, explained later in this chapter. 

Publish: Creates an NWD file. (An NWD file contains all model geometry 

together with Navisworks-specific data, such as review markups, viewpoints, or 

timeline sequence) also available on the Output tab. 

Print: Contains Print, Print Preview, and Print Setup operations. also available on 

the Output tab. 

Send by Email: Saves the current file as an NWD and uses your default email 

application to prepare an email to send. also available on the Output tab. 

Recent Documents: This list shows all of the recently opened documents. You can 

control the order by Size, Access Date, Type, or Ordered List (default). Projects are 

only added to this list with the Normal view selected. If Classic view is used to 
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open a file, no project will be added to this list. All appended files will be added to 

this list when brought into a project. 

Options: Opens the Options Editor. You can also access the Options Editor by 

using Ctrl+F12. 

 

Figure 4 Export fly out 

 

 Quick Access Toolbar: 

The Quick Access toolbar, located 

adjacent to the Application menu, is a series of predefined operations. By default, 

you can find New, Open, Append, Merge, Save, Print, Refresh, Undo, and Redo. 

The Quick Access toolbar is customizable. You can remove tools by right-clicking 

the item you wish to remove or by clicking the down arrow to the right of the bar 

and clicking the option you wish to remove. You can add tools by selecting them 

from the tab and panel locations, right clicking, and then choosing Add to Quick 

Access Toolbar. 

 

 Tooltip: 

If you pause and hover your mouse cursor over any area in Navisworks, you get a 

tooltip, as shown here. Tooltips briefly explain the tool and may contain 
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information about shortcuts (such as pressing Ctrl+ A for Append). Also, if you 

leave your mouse in place a little longer, you will gain a longer explanation of the 

tool, the tooltip will expand into a definition from the help file. 

 

 
Figure 5 Tooltip 

 

 Navisworks Options: 
 

Options, or the Options Editor (sometimes referred to as Global Options), is used to 

adjust the program settings for Navisworks. The settings that you change here are 

retained across different Navisworks sessions. Settings can also be shared across a 

project team via the import/export feature (Figure 6). 

 

Figure 6 Options Editor 
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By looking at each page of the Options Editor: 

GENERAL: Use the General settings (see Figure 7) to adjust the buffer size, file 

locations, number of recent file shortcuts you want Navisworks to store, and the 

Auto-Save options. Additional options include: 

Undo: Specifies the amount of space Navisworks uses for undo/redo operations. 

Locations: Enables the sharing of centralized project information for the project 

directory and site directory. 

Environment: Specifies the maximum number of recently opened files for 

Navisworks to display. The default setting is 4 with a maximum of 16. 

Auto-Save: Controls the settings for the Navisworks Auto-Save feature. From 

here, you can specify the save interval (30 minutes is recommended), the save 

location, and the number of save versions you want to maintain. 

 

Figure 7 General options, with the Auto-Save settings shown 

 

INTERFACE: Use the settings on the Interface page (see Figure 8) to customize 

the behavior of Navisworks. 
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Figure 8 Interface options, with the Snapping options shown 

 

Additional information includes: 

Display Units: Changes the Navisworks display units, Meters are the default 

setting for new Navisworks files. 

Selection: Configures the way geometry is selected and highlighted within 

Navisworks. 

Pick Radius: Specifies the radius that an object has to be within to be selected. 

Resolution: Specifies the level of selection. If you have problems selecting objects, 

you might try changing these settings. 

Compact Tree: Specifies the level of detail to display on the Compact tab of the 

selection tree. 

Highlight: Controls the Highlight settings. When the Enabled box is unchecked, 

selected items are no longer highlighted. 

Measure: Use these options to adjust the settings for the Measure tools. 

In 3D: Allows accurate measurements in 3D. This tool allows you to find the 

distance of 3D objects in a view. When 3D is not selected, Navisworks defaults to a 

2D object defined by the points you select. In 3D changes the way the 

measurements are shown. If the measurement line is obscured by model geometry, 

it will be hidden when in 3D is selected. 
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Use Center Lines: With this check box selected, the Shortest Distance 

measurements snap to the center lines of the selected object. When Use Center 

Lines is not selected, the surface of the object is used. 

Snapping: Enables snaps within Navisworks (Vertex, Edge, and Line Vertex). 

Enabling this tool is useful in conjunction with Measure tools. 

Viewpoint Defaults: These options define the attributes that are saved with saved 

viewpoints. 

Settings: Opens the Default Collision dialog box allow you to control settings from 

the Third Person Avatar. This dialog box can also be accessed from the Viewpoint 

tab under Edit Viewpoints. 

Links: This page allows you to customize how links are displayed within 

Navisworks. 

Quick Properties: Customizes the way Quick Properties are displayed. Use this 

page to set up additional Quick Properties categories or choose to hide Quick 

Properties using this tab. 

Developer: Select this option if you want to enable the Geometry tab and the 

Transform tab within the Properties palette. This tab also enables the use of Hard 

Conservative clash tests. 

Display: Adjusts display performance. 

Occlusion Culling: Select this check box to enable or disable the Culling feature. 

Enabling Culling means that Navisworks draws only visible objects and ignores 

other objects. 

Grids: grids allow you to change the options for the Grids and Levels tool found 

on the View tab. Here, you can change options such as color, font size, and grid 

transparency (X-Ray mode). 

3Dconnexion: Controls the settings for a 3D mouse or motion controller mouse, 

often referred to as a space mouse (including speed). A space mouse can be used as 

an alternative (or in addition) to the mouse to move around the scene view. 
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Navigation Bar: Used for customizing the Navigation Bar and legacy navigation 

tools. 

View Cube: Customizes the behavior of the View Cube tool. 

Steering Wheels: Customizes the behavior of the Steering Wheels tool. 

User Interface: Used to switch between Standard (ribbon) and Classic (toolbars) 

interface mode. 

 

MODEL: 

Use the Model settings (see Figure 9) to optimize the performance of Navisworks 

and to customize parameters for NWD and NWC files.  

 

Figure 9 Model options, with Performance options shown 

Additional options include: 

Performance: Optimizes the performance of Navisworks. 

Memory Limit: Specifies the amount of physical memory that Navisworks uses. 

Merge Duplicates: Allows you to control how and when information is merged 

into Navisworks. 

On Load: Optimizes the performance of Navisworks 

when loading files into Navisworks. 

 Collapse on Convert: Collapses the tree structure. 
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 Close NWC/NWD Files on Load: Controls whether or not the NWC/NWD 

files are locked for editing. When this box is unchecked, the files will be locked 

for editing. Checked means that these files are closed once loaded into memory 

and can be edited. 

 Create Parametric Primitives: Improves speed and performance by using 

parametric objects. 

 Create Presenter Materials: Allows you to create and use materials when an 

NWC file is loaded. 

NWD: Enables and disables geometry compression for the NWD file format. 

NWC: Use this page to manage the file options for the NWC file format. 

Caching: With these boxes checked, Navisworks creates and saves to a cache file, 

or NWC. This is a recommended setting because NWC files are typically smaller 

than their original files. 

The Close NWC/NWD Files on Load Option: 

Depending on your workflow and what your needs are, you should give this check 

box careful consideration. 

If you leave Close NWC/NWD Files on Load unchecked, you will not be able to 

update your NWC/NWD fi les on the fly. In other words, if you are working on an 

active project (coordination meetings, for example) and find yourself updating fi 

les often, you would have to close Navisworks in order to update the NWC/NWD 

fi les loaded in the project. With this box checked, you can modify your files 

during the project. 

FILE READERS: 

Use the File Readers settings (see Figure 10) to configure the file readers required 

to open native CAD, BIM, and scanning application file formats in Navisworks. 
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Figure 10 File Readers page, with options for DWG/DXF shown 

 

DWG/DXF: Adjust options for the DWG/DXF file reader. 

Merge 3D Faces: Allows the file reader to merge the 3D faces of DWG/DXF 

objects into a single item in the selection tree. This helps to lessen the number of 

items selected. 

DWG Loader Version: Allows Navisworks to select which version of the 

Autodesk object enablers to use when loading a DWG file. If the DWG Loader 

Version needs to change, Navisworks must be restarted for this setting to take 

effect. 

Advanced Use the Convert Object Properties dialog box (click Advanced to open 

this dialog) to select third-party applications for the file reader to read additional 

options from (Figure 11). 
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Figure 11 Convert Object Properties dialog box 

 

All other file readers adjust the options for the file type they are associated with. 

TOOLS: Use the Tools settings (see Figure 12) to adjust the options for Clash 

Detective, Presenter, time liner, Scripter, and Animator.  

 

Figure 12 Tools options, with settings for Time liner shown 

Options include: 

Clash Detective: Customizes Clash Detective options. 

Presenter: Customizes Presenter options. 

Profile: You can adjust Presenter profiles to reflect your level of comfort or 

knowledge. The Basic setting is the Navisworks default and has a limited editing 
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functionality. Standard has some advanced Presenter features. Advanced gives you 

access to such features as extra materials, lights, and render styles. 

Interactive Materials: When this check box is cleared; materials are not displayed 

during navigation. This decreases the load on the video card and can improve 

performance. 

Interactive Lighting: When this check box is cleared; lights are not displayed 

during navigation. This decreases the load on the video card and can improve 

performance. 

Time liner: Customizes Time liner options. 

Auto Select Attached Selections: When enabled, automatically selects attached 

objects in Time liner. 

Display Synchronization Errors: When enabled; indicates that error messages 

will display when synchronizing tasks from eternal links in Time liner. 

CSV File: Read and Write Encoding: Specifies the file format of the imported or 

exported CSV file. 

Scripter: Use these options to customize the Scripter settings. 

Animator: A check box indicates whether or not a manual entry is shown in the 

Animator. 

 

IMPORT AND EXPORT: 

These settings allow you to export the current Options settings into an Options 

XML file; you can choose which categories are exported. These items may also be 

imported using the Import feature. 

From a workflow perspective, it may be useful to save individual files for each 

category (General, Interface, and so forth) per project. This way, specific settings 

are retained as needed and can be shared among users quickly and easily. 

 Exploring the Ribbon: 

The ribbon, located at the top of the user interface, is a palette that groups the entire 

Navisworks toolset into an easy to find and use location. The ribbon is divided into 
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tabs, with each tab supporting a specific activity or task. Within each tab is a series 

of panels that contain the available tools. 

While you are not able to add to or remove custom commands from the ribbon, you 

can customize the appearance and location of the panels using these methods: 

 Right-click the tab or panel to open the context menu. From here, you can turn 

tabs or panels on or off. 

 Left-click and hold a specific panel to move its location. You can change its 

location to a new place within the tab or drag it out into the workspace to make 

it more accessible. Panels may not be moved to other tabs. 

 To reset the panel to its default position, right-click on an empty location on the 

panel and click Restore Default Ribbon. 

 

Pushpins: Any time a pushpin icon appears, you can click it to pin an item to the 

screen. This will allow the panel or palette to stay on top and remain open as you 

move to other tools in Navisworks. 

Home: The Home tab contains Project, Select & Search, Visibility, Display, and 

Tools panels (Figure 13 and Figure 15).  

 

 

Figure 13 Home tab, showing additional tools enabled 

PROJECT: 

Append: Appends, or combines, files. The drop-down also contains Merge. 

Refresh: To ensure that you are working with the most current information, 

Navisworks contains a Refresh feature. 

Reset All: Uses the various tools to reset changes applied in Navisworks. 
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Appearance: Returns all color and transparency overrides to their original state. 

Transforms: Resets all Transforms overrides to their original state. 

Links: Resets all links applied to their original state. Deletes all links made in 

Navisworks and retains only links inherited from the original files. 

File Options: This dialog box (see Figure 14) controls the appearance of the model 

as well as the speed of navigation around it. Changes made in this dialog box are 

for the current session only, and options are returned to the defaults when the 

model is closed. 

 

 

Figure 14 File Options dialog box 

 

Culling: Use this tab to adjust geometry culling (that is, the ability to navigate 

large areas) in the open Navisworks file. 

Orientation: Use this tab to adjust the real-world orientation of your model. 

Speed: Use this tab to adjust the frame rate speed to reduce the amount of dropout 

during navigation. 
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Headlight: Use this tab to change the intensity of the scene’s ambient light and 

headlight for Headlight mode. This setting is useful to customize the lighting as 

you navigate. 

Scene Lights: Use this tab to change the intensity of the scene’s ambient light for 

Scene Lights mode. This setting is useful to define a different lighting scheme as 

you navigate the model. 

Data Tools: Use this tab to create and manage links between open Navisworks 

files and external databases. You will not likely use this setting often. 

Scene Statistics: An extremely useful tool, Scene Statistics lists all of the files 

contributing to aggregated elements, or the “scene.” It also shows the various 

graphic elements that help to make up the scene. Use Scene Statistics when an 

object enabler appears to be missing or when certain objects are not showing up 

properly. 

SELECT & SEARCH: 

Select: Allows you to select objects with your mouse. Also available within the 

drop-down list is Select Box, which allows you to select all items within a defined 

box. 

Select All: Selects all objects within the model. 

Select None: Deselects the current selection. Pressing the Esc key has the same 

function. 

Invert Selection: Deselects the currently selected items and selects the currently 

unselected items. In short, it selects the opposite of what you had selected. 

Save Selection: Saves the currently selected objects as a selection set and opens 

the Sets window. The set can then be renamed and modified. 

Select Same: Allows you to select multiple instances of the selected item or group 

of items. Also opens to the Select Same drop-down for additional selection criteria 

and options. 
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Selection Tree: Toggles the selection tree on and off. The selection tree is a palette 

that displays a variety of categorized views of the structure of the model depending 

on the loaded model. 

Find Items: Toggles the Find Items palette on and off. 

Quick Find: A simplified version of Find Items, Quick Find allows you to search 

the scene using the Quick Find dialog box. 

Sets: Displays a list of defined search and selection sets. You can access the Sets 

palette from this drop-down. 

Selection Inspector: Displays a list of all selected objects showing their Quick 

Properties information. Quick Properties information can be customized in the 

Options Editor. 

VISIBILITY: 

Hide: Hides selected items from display. You can select multiple items to hide 

them and at different intervals. The items also appear grayed out in the selection 

tree to represent hidden. 

Require: Forces an item to remain visible regardless of performance settings, such 

as culling. When an item is set to Required, it will appear red in the selection tree. 

Required items can still be hidden; the required setting is mainly to help ensure that 

items will not be dropped from view when you have to change your performance 

settings. 

Hide Unselected: Hides all items except those that are currently selected. This tool 

is useful when you’re trying to build a selection set and ensure the items that you 

have selected. 

Unhide All: Reveals all hidden items in the scene. The drop-down also contains 

Unrequire all, which sets required items back to optional. 
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Figure 15 Home tab continued 

 

DISPLAY: 

Links: Displays or hides links. Several types of links display in Navisworks: 

Hyperlink, Label, Viewpoints, Clash Detective, TimeLiner, Sets, Redline tags, and 

user-defined links. You can use the Options Editor to toggle the display of each of 

the link categories and also to control their appearance. 

Quick Properties: When enabled, Quick Properties displays brief information 

about the object in a tooltip type of display. You can edit the type of information 

that is displayed in the Options Editor. 

Properties: Toggles the Properties palette on and off. The Properties palette 

displays available properties for a selected item. If more than one item is selected, 

the Properties palette will display only the total number of selected items and no 

additional property information. 

TOOLS: 

Clash Detective: Toggles the Clash Detective palette on and off. Clash Detective 

enables you to interactively search your model for clashes or interferences. 

TimeLiner: Toggles the TimeLiner palette on and off. TimeLiner allows you to 

create 4D simulations of your project, linking time with modeled objects. 

Presenter: Toggles the Presenter palette on and off. Presenter allows you to apply 

materials and lighting to your model to aid in creating renderings. 

Animator: Toggles the Animator palette on and off. Animator allows you to 

animate objects to bring realism to your project. 

Scripter: Toggles the Scripter palette on and off. Scripter adds interactivity to your 

animated objects. 
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Batch Utility: Opens the Batch Utility dialog box. From here, you can create a list 

of all design files, append multiple design files into a single NWD or NWF file, 

and convert multiple design files into individual NWDs. 

Appearance Profiler: Toggles the Appearance Profile palette on and off. This tool 

lets 

you create custom appearance profiles for items based on properties or sets (Search 

and Selection). Then you can use the appearance profiles to essentially color-code 

the objects in your model to help identify or differentiate status or type. 

Compare: Opens the Compare dialog box. You can look for differences between 

any two items selected in the model. These items can be files, layers, instances, 

groups, or geometry. 

Data Tools: Opens the Data Tools dialog box. From here, you can connect 

Navisworks to external databases and create links to objects within the model. 

Viewpoint: The Viewpoint tab contains the Save, Load & Playback panel as well 

as the Camera, Navigate, Render Style, Sectioning, and Export panels (Figure 16 

and Figure 17). 

 

Figure 16 Viewpoint tab 

 

SAVE, LOAD & PLAYBACK: 

Save Viewpoint: Saves a viewpoint of the current view. The saved viewpoint 

retains the properties and attributes of the current view when the Save Attributes 

setting in the Options is selected. There is also a Record feature to record your 

actions (Walk, Fly, Zoom, and other actions in Navisworks). The recording is 

saved in the Saved Viewpoints window. 

Animation Controls: See “Playback” in the section “Animation.” 
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Edit Viewpoint: Opens the Edit Viewpoint dialog box. This dialog box allows you 

to edit any viewpoints attributes, including camera position, field of view, speed of 

motion, and saved attributes. The Collision dialog box is located within the Edit 

Viewpoint dialog box, allowing you to adjust collision settings for the current 

viewpoint. 

 

Saved Viewpoints Dialog Launcher: toggles the saved viewpoints palette. 

CAMERA: 

Perspective: Allows you to choose between Orthographic or Perspective mode. 

Walk and Fly navigation tools are not available in Orthographic mode. Tip: If the 

view becomes distorted when you switch between modes, undo the switch, use the 

Focus tool, and then switch modes. 

Field Of View (F.O.V.): Defines the area of the scene that the camera can view. 

The lower the number, the narrower the camera angle or the closer you are to the 

object being viewed. You can you edit existing or saved Field Of View settings 

using the Edit Viewpoint dialog box. The higher the number is, the more distorted 

the model looks. 

Align Camera: Opens the Align Camera drop-down, which allows you to use 

these tools to align the camera to the chosen axis: 

Align X Aligns the camera to the x-axis. 

Align Y Aligns the camera to the y-axis. 

Align Z Aligns the camera to the z-axis. 

Straighten: A useful tool to straighten the view when you find yourself askew, 

which can often occur when using some of the navigation tools such as Fly and 

Orbit. It works only when the view is within 13 degrees of a face of the View 

Cube. 

Show Tilt Bar: Toggles the Tilt Bar off and on. Tilt adjusts the vertical angle of 

the camera. 
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Figure 17 Viewpoint tab continued 

 

NAVIGATE: 

Navigate Tools: Included on the Viewpoint tab are Navigation tools to help to 

move around the model. Here, you can find tools for Pan, Zoom Window, Orbit, 

Look Around, Walk, and Steering Wheels. Most of these tools can also be found on 

the Navigation Bar. 

Realism: Toggles the Realism settings on and off for the following options. 

(Figure 3.21) shows one result of working with Realism settings: a construction 

worker avatar in a crouching position. 

Collision: Enabling Collision allows you to navigate the model with mass. As you 

interact with the model and come into contact with objects like doors or columns, 

you stop or are unable to pass through that object. You can change or customize the 

size of the Collision Volume to reflect the needs of the user or collision 

requirements. Collision can only be used with the Walk and Fly tools. 

Gravity: This tool gives you the appearance of weight. When you are using the 

Walk tool and you begin to move, you will “fall” until you reach a surface. Gravity 

works best when Collision is also active so that when a surface is contacted, the 

falling stops. Use Gravity in conjunction with Collision to walk up or down stairs. 

Gravity can only be used with the Walk tools. If Gravity is selected, Collision is 

automatically turned on. You cannot have Gravity without Collision. 

Crouch: with Crouch activated, you will automatically crouch under any objects 

that you cannot freely walk under at the specified avatar height. This can be useful 

for checking clearance heights under pipes and other equipment. 
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Third Person: When Third Person is active, it turns on Third Person view, or an 

avatar, which you can use as a representation of yourself while navigating the 

model. Third 

Person has other added benefits like working with Gravity, Collision, and Crouch. 

When you’re using the avatar for Collision, it will turn red when it approaches 

another item. Also, you can customize Third Person by changing the avatar 

selection and dimensions. 

Linear Speed: Sets the linear speed, which is the speed the Walk and Fly tools use 

when navigating through the model. The 5-10 ft/sec range is ideal for an average 

walking pace. 

This is a temporary setting specific to the view. If you change views, this setting 

will go back to the project default. 

Angular Speed: Sets the angular speed, which is the speed at which the Walk and 

Fly tools turn when navigating through the model. The 45-60 deg/sec range is ideal 

for an average walking pace. 

 

Figure 3.18 Third Person with Gravity, Collision, and Crouch enabled 

RENDER STYLE: 

Lighting: Changes the Lighting mode within Navisworks to control how the 3D 

scene lighting is displayed. 

 Full Lights: Uses the highest quality lighting available. Controlled by 

Presenter. 
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 Scene Lights: Uses the lights supplied with the 

appended files. If no lights are added, Navisworks will 

add two opposing lights. You can change the ambient 

lighting options using the File Options tool. 

 Headlights: Uses a light that comes from the camera 

location. You can change the ambient lighting option 

using the File Options tool. 

 No Lights: does not use any lights in the view; geometry is rendered with 

flat lights. 

Mode:  

The Mode drop-down controls the options for displaying the scene geometry 

rendering and the level of materials to display. 

Full Render: in Full Render mode, the model is shown 

with materials and textures along with edges and smooth 

shading. 

Shaded: The model is shown with additional edges and 

smooth shading. Materials and textures are not included in 

this mode. 

Wireframe: The model is shown in Wireframe mode 

only. Materials and textures are not included in this mode. 

Hidden Line: The model is shown in Wireframe mode but only outline and facet 

edges are displayed; this hides additional lines over Wireframe mode. Materials 

and textures are not included in this mode. 

Surfaces: toggles 3D surface geometry on and off. 

Lines: toggles on and off the 2D lines that come from an appended file. 

Points: toggles on and off the points that come from appended files. When you are 

inserting point cloud or laser scan data, it may be necessary to have the points 

enabled. 

Snap Points: Toggles on and off the rendering of snap points within the model. 
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Text: Toggles on and off 2D or 3D text that comes from appended files. 

Using a combination of these tools when bringing in an AutoCAD file or other 

vector-based file types helps to clean up the scene in Navisworks and create a 

display of only 3D geometry. 

 

SECTIONING: 

Enable Sectioning: 

Opens the Sectioning Tools tab (Figure 19). The Sectioning tools allow you to 

create cross-sections of your model. Sections can enabled and disabled as needed. 

 

Figure 19 Sectioning Tools tab 

 

 

EXPORT: 

Image: Saves an image file of the current view. 

Rendered Image saves a rendered image of the current view. 

Piranasi EPix Saves a Piranasi EPix file of the current view. 

Review: The Review tab contains Measure, Redline, Tags, Comments, and 

Collaborate panels (Figure 20). 

 

Figure 20 Review tab 
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MEASURE: 

Measure: 

Navisworks has tools that allow you to measure between points, calculate area, and 

convert measurements to redlines. The Measure tools are independent of 

Navigation tools. if you activate the Navigation tools (walk, fly, orbit, pan), you 

will have to go back to your Measure tools after using any of the Navigation tools. 

However, you can use the mouse tools for navigation (mouse orbit, pan and zoom) 

without affecting the Measure tools. Using the mouse tools can help you to also 

move to better align your measurement. Use right-click or the Esc key to cancel 

any of the Measure tools. to clear the screen of the measurement after placement, 

use Clean as explained below. 

Point to Point: Measures the distance between two points. 

Point to Multiple Points: measures the distance between a starting point or base 

point and any number of additional selected points. 

Point Line: Measures consecutive linear distances. 

Accumulate: Measures the total length of nonconsecutive linear measurements 

(keeps a running total of the linear measurements) until cleared or canceled. 

Angle: Measures the angular distance as defined by three selected points. 

Area: Measures the area of selected points. 

Shortest Distance: Measures the shortest distance between two selected objects 

(two objects must be selected; use the Ctrl key to select the objects as needed). 

Convert To Redline: Clears the measurement and converts it to a redline. 

The redline will be saved as part of the active viewpoint. If no viewpoint is 

selected, the Convert to Redline tool will create a new viewpoint automatically. 

Clear: Clears the current measurement from the screen. 

Transform Selected Items: Moves or rotates the currently selected object the 

distance specified by a measuring tool. Use Transform Selected Items to move the 

object in the direction that you specified. For example, if you selected the bottom 

of an object and then the top of an object with a measuring tool, your object will be 
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moved up. Keep in mind that this is not a temporary transform that can be reset by 

using Reset Transform, but that it affects the file units and transforms; this is a 

permanent change to the object. 

 

Moving an Incorrect Element: 

Learning to use the Measure Transform tool can sometimes mean the difference 

between a project moving smoothly and a project with additional conflicts because 

of  

a misplaced appended item. There are times during an Append or Merge operation 

when objects could be improperly aligned, even given the best efforts of the project 

team. There is good news, though; all items in Navisworks can be moved. In most 

cases, entire file sets are selected and transformed to a new location. (see figure 21) 

 

Figure 21 Measure Transform tool 

Using the Measure Transform tool in conjunction with the selection tree lets you 

specify a distance to relocate the object. It helps to know a good reference or 

common location between the items when selecting your points. Another good idea 

is to have your snaps enabled when using the Measure Transform tool to help with 

selecting points.  
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REDLINE: 

Draw: 

Allows you to add redline shapes and text notes to your model. Redlines can only 

be added to a saved viewpoint or to a clash, which has a saved viewpoint. If there 

are no saved viewpoints, adding a tag will automatically create and save a 

viewpoint for you. Otherwise, you will receive an error, and you’ll have to save a 

viewpoint before adding any redlines. 

 

Color: Allows you to change the color of redlines. 

Thickness: Changes the line thickness of the redlines being added; 9 is the 

maximum thickness. 

 

TAGS: 

Add Tag: 

Inserts a tag into your model. If you have a viewpoint selected, the tag will be 

created within that viewpoint; otherwise, the tag will create its own viewpoint. 

Tag ID: Allows you to enter the tag ID or number to use with Go to Tag. 

Go to Tag: once you enter the desired number, you can use the Go to Tag tool to 

take you to the tag. 

Tag Selection: Scrolls through the tag and its associated viewpoints. 

Renumber Tag IDs: Used to renumber the tag IDs; removes duplicates. This tool 

is useful when you’re appending or merging fi les that may have existing tag IDs. 

 

COMMENTS: 

View Comments: 

Toggles the comments palette on and off. From here, you can manage the 

comments created throughout the model. 

Find Comments: Opens the Find Comments palette. You can search through both 
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comments and tags for text, author, comment ID, status, comment, and date 

modified. 

Renumber Comment IDs: Used to renumber the comment IDs; removes 

duplicates. This tool is useful when you’re appending or merging fi les that may 

have existing comment IDs. 

 

COLLABORATE: 

Collaborate: Enables a collaboration session using Windows NetMeeting. 

Drive: Enables the user to become the driver of a remote computer. 

Refresh: Shares model updates with each member of the team. 

 

Animation: 

This tab contains the Create, Playback, Script, and Export panels (Figure 22). 

 

Figure 22 Animation tab 

 

CREATE: 

Animator: 

Toggles the animator palette on and off (same as the animator located on the home 

tab). Animator allows for the animation of objects to bring realism to your project. 

Record: Begins to record your actions (Walk, Fly, Zoom, and other actions in 

Navisworks). 

The recording is saved as an animation in saved viewpoints that you can later edit 

or add to as needed. 
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PLAYBACK: 

After an animation has been created, you gain access to the Playback tools. From 

the dropdown, select the animation that you wish to play, and use the tools 

available to play the animation. 

You can also use the slide at the bottom of Playback to manually change the 

display of the playback. 

 

SCRIPT: 

Enable Scripts: 

Enables and disables scripts. Once a script has been created, it has to be enabled 

before the action created can be utilized. For example, if you created a script to 

operate a door on approach, enabling scripts will allow this to occur. 

Scripter: Toggles the Scripter palette on and off (same as the Scripter located on 

the Home tab). The Scripter adds interactivity to your animated objects. 

EXPORT: 

Export Animation: Exports the current animation. 

View: The View tab contains Stereo, Navigation Aids, Grids & Levels, Scene 

View, and Workspace panels (Figure 23). 

 

Figure 23 View tab 

 

STEREO: 

Enable Stereo: Stereo, or stereoscopic viewing, allows you to view the 3D model 

through stereo-enabled hardware (i.e., in true 3D), including active and passive 

stereo viewing glasses. This option is only available if you have the required 

hardware as well as the correct driver and display settings. 
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NAVIGATION AIDS: 

Navigation Bar: Toggles the Navigation Bar on and off. Contains View Cube, 

Steering Wheels, Pan, Zoom, Orbit, Look, Walk, and Fly tools. 

View Cube: Toggles the View Cube on and off. The View Cube allows you to 

switch between views of your model. Use View Cube to set a Home view that you 

can easily get back as you navigate around your model. 

HUD: In Head Up Display, or HUD for short, the x-, y-, and z-axes, the position 

readout, and the grids display on and off. All of the HUDs are displayed in the 

lower-left corner of the screen. 

XYZ Axes: As you can see in Figure 24, this option shows the X, Y, Z visual 

orientation of the camera (or the Third Person position if Third Person has been 

enabled). 

Position Readout: As you can see in Figure 24, this option shows the X, Y, Z 

textual position of the camera (or the Third Person position if Third Person has 

been enabled).  

Grids: Displays the Grid location HUD, as shown in Figure 24. With the Grid 

HUD turned on, you can see your level as well as the grid reference. 

 

Figure 24:  XYZ axes, position readout, and grids 

 

Reference Views: toggles the Plan and Section views on and off. Both reference 

views allow you to gain perspective and location within your model, especially in 

large models. To use this feature, drag the white triangle to move yourself around. 

Additional tools are available on the context menu to aid in navigation. 
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GRIDS & LEVELS: 

Show Grid: Toggles the grid on or off. 

Mode: Allows you to change how the grid is displayed in Navisworks. Choose 

from Fixed, Below, Above, or Above And Below. 

File: Permits you to choose the active file and change settings for the grids as 

needed. 

Level: Controls the default level based on the active file. 

 

SCENE VIEW: 

Full Screen: Clears away all tabs and palettes and displays Navisworks in Full 

Screen mode. Press F11 to exit Full Screen mode and return to your tools. 

Split View: Allows you to add horizontal and vertical screen splits. Each view can 

be set to represent a different view of the model. Only one view can be active at a 

time. 

Background: Opens the Background Settings dialog box, which allows you to 

change the background color and scheme. 

Window Size: Opens the Window Size dialog box, which allows you change the 

size of the Navisworks canvas. If you change the size and want to return to the 

default, change back to Use View. 

Show Title Bars: Show or hides the title bars on secondary display view windows. 

 

WORKSPACE: 

Windows: Serves as a central list all of the palettes and toggles them on and off. 

Load Workspace: Workspaces retain information about which windows are open, 

their positions, and the size of the application window. The Load Workspaces 

drop-down contains predefined workspaces as well as any custom workspaces. 

Workspaces do not maintain changes to the ribbon but do include changes made to 

the Quick Access toolbar. 

Safe Mode Opens the workspace with minimal features. 
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Navisworks Minimal: Loads the workspace with the fewest tools and most space 

in the scene. 

Navisworks Standard: Loads the workspace with the most commonly used tools 

and palettes. 

Navisworks Extended: Opens the workspace with the most tools. This workspace 

is recommended for advanced users. 

More Workspaces: Opens previously saved workspaces. 

Save Workspace: Saves the current workspace as an XML file. 

Output: 

The Output tab contains Print, Send, Publish, Export Scene, Visuals, and Export 

Data panels (Figure 25 and Figure 27). 

 

Figure 25 Output tab 

PRINT: 

Print: Sends the current view to a printer. 

Print Preview: Creates a preview of the view to be printed. 

Print Settings: Allows you to specify the printer settings. 

SEND: 

Send By Email: Saves the current file and uses your default email application to 

prepare an email to send. It can be used to send either an NWF or NWD file, but an 

NWD file is considerably larger. Make sure the file size meets the requirements of 

the email provider. 
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PUBLISH: 

NWD: Creates an NWD file (NWD is a file that contains all model geometry 

together with Navisworks-specific data, such as review markups, viewpoints, or 

timeline sequence). You can also set options such as May Be Re-saved or set the 

file to expire within a certain timeframe (Figure 26). 

When using Publish to create an NWD file, you can’t save to previous versions of 

Navisworks, but you have access to all the other features and functions of Publish. 

If you need to create an NWD file for an older version of Navisworks, you will 

have to use Save As instead. 

The downside is that you will no longer have access to the Publish options. 

 

Figure 26 Publish dialog box 
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EXPORT SCENE: 

3D DWF: Exports all materials and geometry into a 3D DWF file. 

FBX: Exports an FBX file out of Navisworks. allows you to include things like 

lights, cameras, and textures in your export. 

Google Earth KML: Google Earth KML files can be exported from Navisworks. 

The exporter creates a compressed KML file with the extension .kmz. 

VISUALS: 

 

Figure 3.27 Output tab continued 

 

Image: Opens the export image dialog box. This dialog box allows you to export 

an image of the current scene. 

Rendered Image: Opens the rendered image dialog box, which allows you to 

export a rendered image. 

Animation: Opens the Animation Export dialog box. You can choose from Source, 

Renderer, Output Type, and Size. 

Piranesi EPix: Exports an EPX file for rendering in Piranesi from Informatix. 

 

EXPORT DATA: 

Clash Tests: Exports the settings for all of the clash tests created in Clash 

Detective into an XML file. 

Timeliner CSV: Exports the current Timeliner tasks into a CSV file. 

Current Search: Saved Find Items criteria can be exported from Navisworks into 

an XML file and imported into other sessions of Navisworks. 
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Search Sets: Saved search sets can be exported from Navisworks into an XML file 

and imported into other sessions of Navisworks. 

Viewpoints: Exports all of the viewpoints into an XML file. This is a text-based 

XML file and the images are not exported. This file contains all associated data, 

including camera positions, sections, hidden items, material overrides, redlines, 

comments, tags, and collision detection settings. The XML file can be imported 

into other Navisworks files, and it creates all the views from the original project. 

Viewpoints Report: Creates an HTML file or report of JPEG files of all saved 

viewpoints. 

The report contains camera position, comments, and other associated data. If you 

have created an animation, the report will also include the animation frames as 

individual images as part of the report. 

PDS Tags: Exports all PDS tag data from the model into a TAG file. 

Status Bar, Performance Indicators, and Context Menus: 

Located in the bottom-right corner of the screen is the status bar, which contains 

four performance indicators that give you feedback on the performance of your 

computer and currently loaded Navisworks model (Figure 28). 

 

Figure 28 Status bar 

 

Pencil Bar: Indicates how much of the current view is drawn, that is, how much 

image dropout there is in the current view. When the progress bar is at 100 percent, 

the scene is completely drawn, with no dropout. The icon changes color when a 

redraw is in progress. While the scene is being drawn, the pencil changes to yellow. 

If there is too much data to handle and your computer cannot process this quickly 

enough for Navisworks, then the pencil changes to red, indicating dropout. 
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Disk Bar: Indicates how much of the current model is loaded from the local hard 

drive. When the progress bar is at 100 percent, the entire model, including 

geometry and property information, is loaded into memory. The icon changes color 

when a file load is in progress. While the data is being read, the disk changes to 

yellow. If there is too much data to handle and your machine cannot process it 

quickly enough for Navisworks, then the disk changes to red, indicating a potential 

problem. 

Web Server Bar: Indicates how much of the current model is downloaded from a 

web server. When the progress bar is at 100 percent, the entire model has been 

downloaded. The icon changes color when a file load is in progress. While data is 

being downloaded, the web server changes to yellow. If there is too much data to 

handle and your computer cannot process it quickly enough for Navisworks, then 

the web server changes to red, indicating a potential problem. 

Memory Bar: Indicates the amount of system memory being utilized by 

Navisworks. 

Navisworks uses a few context menus that contain various tools. These tools can 

help you save time once you master when and how to leverage them. 

No Item Selected: This context menu (Figure 29) has a variety of tools that are 

found across various tabs and toolbars within Navisworks but that have been 

centralized for easy access. Access this menu by right-clicking in white space away 

from geometry. Once the menu is open, select your tool. 

 

Figure 29 Context menu, with no items selected 
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With Item Selected: The With Item Selected context menu contains even more 

tools to help you along your way. Access this menu (Figure 30) by right-clicking 

once you’ve selected the geometry. If you right-click when no geometry is selected 

(right-clicking on the object instead of selecting it first), Navisworks will select that 

single piece of geometry and open this context menu as well, saving you the step of 

having to select the object first. 

 

Figure 30 Context menu, with an item selected 

 

The Bottom Line: 

Understand the ribbon: Knowing the locations of various tools within the Ribbon 

provides a good foundation for being able to quickly access items across the 

Navisworks interface. 

Use the Measure and Redline tools: The Measure and Redline tools are useful in 

Navisworks throughout a project, and having a basic understanding of these tools is 

essential. 
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 TimeLiner Tool:- 

Timeliner tool used in linking models with an external construction schedule for 

visual time and cost based planning. 

There is four tabs included in timeliner: 

1- Task:  

The Task view: 

The tasks are shown in a multi-column table, which provides some flexibility in 

how records are displayed. You can:  

• Move or resize columns  

• Sort column data in ascending or descending order  

• Add new user columns to the default column set  

Tip: You can move between entries with the keyboard. Simply select a task, and 

use Tab and SHIFT + Tab keyboard keys to move forwards and backwards 

between fields. The keyboard can then be used to edit and set each entry where 

necessary.  

The Task Hierarchy 

 Autodesk Navisworks TimeLiner supports a hierarchical task structure, as 

imported from a data source, for example Microsoft Project. The hierarchy can be 

expanded or contracted by clicking on the plus or minus sign, respectively, to the 

left of the task.  

The Status Icons 

Each task has its own status identified by an icon. Two separate bars are drawn for 

each task, showing planned against actual relationships. The color is used to 
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differentiate the early (blue), on-time (green), late (red), and planned (gray) 

portions of the task. Dots mark the planned start and end dates.  

Placing the mouse pointer over a Status icon shows a tooltip explaining the task 

status.  

Finished before planned start. 

Early start, early finish. 

Early start, on-time finish. 

Early start, late finish. 

On-time start, early finish. 

On-time start, on-time finish. 

On-time start, late finish. 

Late start, early finish. 

Late start, on-time finish. 

Late start, late finish. 

Started after planned finish. 

No comparison. 

The Active Check Box 

The check box in the Active column enables you to turn a task on/off. If a task is 

turned off, then it will not appear in the simulation. For hierarchical tasks, turning 

off the parent task will automatically turn off all child tasks.  
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The Context Menus 

Right-clicking within the tasks area on the tab, opens a context menu that enables 

you to work with tasks in your schedule.  

 • Copy Date/Time: copies date/time values in the selected field. This option is only 

available when you right-click one of the date fields (for example, Planned Start).  

Note: Currently, you cannot use the CTRL + C keyboard shortcut to copy date/time 

values.  

• Paste Date/Time: pastes date/time values. To access this option you need to right-

click one of the date fields. Also, this option is not available unless a valid 

date/time has been previously copied.  

Note: Currently, you cannot use the CTRL + V keyboard shortcut to copy 

date/time values.  

•Enable Planned Dates: Simulate Planned Dates for the selected task. This option is 

available when you right-click the Planned Start or the Planned End field.  

•Enable Actual Dates: Simulate Actual Dates for the selected task. This option is 

available when you right-click the Actual Start or the Actual End field.  

•Dates: Enables you to simulate actual and planned dates for the selected task. If no 

dates are enabled for the task, then it will not appear in the simulation.  

•Add Task: adds a new task to the schedule. This option is available when you 

right-click in an area of the task view below any current tasks.  

• Attach Current Selection: attaches the currently selected items in the scene to the 

selected tasks.  

• Attach Current Search: attaches all items selected by the current Search to the 

selected tasks.  
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• Attach Set: attaches all items contained within a Selection Set, to the selected 

tasks. When you choose this option a list of all Selection and Search Sets saved in 

the current scene is displayed. Choose the Selection or Search Set you wish to 

attach to the tasks.  

• Append Current Selection: appends the currently selected items in the scene to 

the items already attached to the selected tasks.  

Note: See Select Objects for more information on how to select items in Autodesk 

Navisworks.  

• Clear Attachment: removes the attachment from this task.  

• Add Comment: adds a comment to the task.  

• Fill Down: sets the Task Type of all currently selected tasks in the Tasks view to 

match that of the task that is currently 'in focus'.  

• Insert Task: inserts a new task above the one currently selected in the Task view.  

• Delete Task: deletes the task currently selected in the Task view.  

• Auto-Add Tasks: automatically adds a task for every topmost layer, top-most 

item, or every search and selection set.  

• Find: finds items in a schedule based on the search criteria that you select in the 

Find menu. This option can be turned on/off in the Options Editor (Tools  

TimeLiner  Enable Find check box).  

You can use multi-selection (i.e. holding down SHIFT or CTRL) to perform most 

commands on several tasks at once. For example, should you need to delete all 

tasks, select the first task, then hold down SHIFT and select the last task, then press 

Delete. 
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Task Buttons:  

Add Task   

The Add Task button adds a new task as the bottom of the tasks list.  

Insert Task  

The Insert Task button inserts a new task above the one currently selected in the 

task view.  

Auto-Add Tasks  

The Auto-Add Tasks button automatically adds a task for every top most layer, top 

most items, or every search and selection set.  

Delete Task  

The Delete Task button deletes the tasks currently selected in the Task view.  

Attach  

The Attach button enables you to:  

 Attach Current Selection: attaches the currently selected items in the scene to the 

selected tasks.  

 Attach Current Search: attaches all items selected by the current Search to the 

selected tasks.  

 Append Current Selection: appends the currently selected items in the scene to 

the items already attached to the selected tasks.  

Auto-Attach Using Rules  

 The Auto-Attach Using Rules button opens the TimeLiner Rules Dialog Box 

where you can create, edit and apply rules for automatically attaching model 

geometry to tasks.  

file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-9B1E1227-3CB2-44FE-8870-A857304843B2.htm
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Clear Attachment  

The Clear Attachment button detaches the model geometry from the selected tasks.  

Find Items  

The Find Items button enables you to find items in a schedule based on the search 

criteria that you select from the drop-down list. This option can be turned on/off in 

the Options Editor (Tools TimeLiner Enable Find check box).  

Move Up  

The Move Up button moves the selected tasks up the task list. Tasks can only move 

with their current level of hierarchy.  

Move Down  

The Move Down button moves the selected tasks down the task list. Tasks can only 

move with their current level of hierarchy.  

Indent  

The Indent button indents the selected tasks by one level in the task hierarchy.  

Outdent  

The Outdent button outdents the selected tasks by one level in the task hierarchy.  

 

Add Comment  

The Add Comment button adds a comment to the task.  

Columns  

The Columns button enables you choose one of three pre-defined column sets to 

display in the Tasks view; Basic, Standard or Extended. Alternatively you can 

create a customized column set in the Choose TimeLiner Columns Dialog Box by 

file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-E1D5D899-139B-4CDD-B27F-690F254BD1B5.htm
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clicking Choose Columns, then selecting Custom when you have set up your 

preferred column set.  

Filter by Status  

The Filter by Status button enables you to filter tasks based on their status. Filtering 

a task temporarily hides the task from the Task and Gantt Chart views, but does not 

make any changes to the underlying data structure.  

Export Schedule  

The Export Schedule button enables you export a TimeLiner schedule as a CSV or 

Microsoft Project XML file.  

The Gant Chart veiw:  

The Gantt Chart displays a colored bar chart illustrating your project status. 

Each task takes up one row. The horizontal axis represents the time span of the 

project, broken down into increments (such as days, weeks, months, and years) and 

the vertical axis represents the project tasks.  

Tasks can run sequentially, in parallel, or overlapping.  

You can drag a task to different dates, or click and drag on either end of the task to 

extend or shorten its duration. Any changes are automatically updated in the Task 

view.  

Gant Chart Button:  

The Display Dates 

The Display Dates drop-down enables you to switch between Actual, Planned, and 

Planned vs. Actual Gantt charts.  

Show/Hide Gantt Chart  

Click the Show/Hide Gantt Chart button to show or hide the Gantt chart.  
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Show Planned Dates  

Click the Show Planned Dates button to show Planned Dates in the Gantt chart.  

Show Actual Dates  

Click the Show Actual Dates button to show Actual Dates in the Gantt chart.  

Show Planned vs. Actual Dates  

Click the Show Planned vs. Actual Dates button to show Planned vs. Actual Dates 

in the Gantt chart.  

The Zoom Slider 

The Zoom slider enables you to adjust the resolution of the displayed Gantt chart. 

The utmost left position selects the smallest available increment in the timeline (for 

example, days); the utmost right position selects the largest available increment in 

the timeline (for example, years).  

Filter by Status  

The Filter by Status button enables you to filter tasks based on their status. Filtering 

a task temporarily hides the task from the Task and Gantt Chart views, but does not 

make any changes to the underlying data structure.  

Export Schedule  

The Export Schedule button enables you export a TimeLiner schedule as a CSV or 

Microsoft Project XML file.  

2- Data Source Tab:  

The Data Source Button: 

Add 

Creates a new connection to an external project file. Clicking this button displays a 

menu listing all project sources that may be connected to on the current machine. 
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See Supported Scheduling Software for more information on which sources are 

available. 

Delete 

Deletes the currently selected data source. If you have refreshed the data source 

before you deleted it, any tasks and data read from the data source will remain on 

the Tasks tab.  

Refresh 

Displays the Refresh from Data Source Dialog Box where you can refresh the 

selected data sources.  

The Context Menus: 

Right-clicking within the data source area on the tab opens a context menu that 

enables you to manage data sources.         

 • Rebuild Task Hierarchy: reads all of the tasks and associated data (as defined in 

the Field Selector Dialog Box) from the selected data sources and adds these to the 

Tasks tab. Choose this option also to synchronize with the selected project file 

when new tasks have been added to the project file. This will rebuild the task 

hierarchy in TimeLiner, containing all of the latest tasks and data.  

• Synchronize: Updates all existing tasks in the Tasks tab, with the latest associated 

data from the selected data sources (for example, Start and End dates).  

• Delete: deletes the currently selected data source. If you have refreshed the data 

source before you deleted it, any tasks and data read from the data source will 

remain on the Tasks tab.  

• Edit: enables you to edit the selected data source. This will display the Field 

Selector Dialog Box, from which you can define new fields or re-define existing 

ones.  

•Refresh: displays the Refresh from Data Source Dialog Box where you can refresh 

the selected data source.  

file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-1879F810-B3D3-419A-A138-0D2F02A8BFBA.htm
file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-8C7CAB0A-4BEA-4AAD-A235-1F03F4E480AC.htm
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•Rename: enables you to rename the data source to something more appropriate. 

When the text field becomes highlighted, enter the new name, then press Enter to 

save it.  

Note: Tasks in the data source will be ignored if they do not include both start and 

end dates, with the start date being less than or equal to the end date.  

3- Configure Tab:  

Add: Adds a new task type.  

Delete: Deletes the selected task type.  

Appearance Definitions 

Use this dialog box to customize the default task types, or create new ones, as 

necessary. To access it, click the Appearance Definitions button on the Configure 

tab.  

 

Figure 31 Appearance Definitions window 



108 
 

  TimeLiner comes with a set of ten predefined appearance definitions that you can 

use to configure the task types. Appearances define a level of transparency and a 

color.  

Name: Specifies the appearance definition name. Click on the name to change it as 

required.  

 Color: Specifies the appearance definition color. Click on the color to change it as 

required.  

 Transparency: Specifies the appearance definition transparency. Use the slider or 

enter a value to change the transparency as required.  

 Add: Click to add an appearance definition.  

 Delete: Click to delete the currently selected appearance definition.  

 Default Simulation Start Appearance: This drop-down box specifies a default 

appearance to apply to all objects in the model at the start of the simulation. The 

default is Hide, which is ideal for simulating most construction sequences.  

4- Simulate Tab:  

The Simulate tab enables you to simulate your TimeLiner sequence throughout the 

duration of the project schedule.  

The playback controls: 

Use the standard VCR buttons to step and play forwards and backwards through 

the simulation:  

Rewind  will rewind the simulation back to the beginning.  

Step Back  will step back a single step size.  

Reverse Play  will play the simulation backwards.  
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Pause  will pause the simulation at the time you press it at. You can then look 

around and interrogate the model, or step forwards and backwards through the 

simulation. To continue playing from where you paused, just press Play again.  

Stop  will stop the simulation playing and rewind back to the beginning.  

Play  will play the simulation from the currently selected time.  

Step Forwards  will step forwards a single step size.  

Forward  will fast forward the simulation to the end.  

You can use the Simulation Position slider to quickly move forwards and 

backwards through the simulation. Full left is at the beginning and full right is at 

the end.  

 

The Date/Time box next to the VCR buttons shows the point in time through the 

simulation. You can click on the drop-down icon to the right of the date to display 

a calendar, from which you can select a date to 'jump' to.  

Simulation Settings Dialog Box:  

The Settings button on the Simulate tab provides access to the Simulation Settings 

dialog box.  

file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-E296880A-1607-4755-9A99-D92ECD43463E.htm
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Figure 32 Simulation settings window 

It is possible to override the Start and End dates that the simulation runs between. 

Selecting the Override Start/End Dates check box enables the date boxes and 

allows you to choose the start and end dates. By doing this, you can simulate a 

small sub-section of the overall project. The dates will be shown on the Simulate 

tab. These dates will also be used when exporting animations.  

You can define the Interval Size to use when stepping through the simulation using 

the playback controls. The interval size can be set either as a percentage of the 

overall simulation duration or to an absolute number of days or weeks, and so on.  
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Use the drop-down list to select the interval unit, then use the Up and Down arrow 

buttons to increase or decrease the interval size.  

 

 

Figure 33 Interval size in Simulation settings window 

It is also possible to highlight all the tasks that are being worked on during the 

interval. By selecting the Show All Tasks in Interval check box, and, for example, 

setting the Interval Size to 5 Days, all tasks being worked on during those 5 days 

will be set to their Start Appearance in the Scene View, including those that begin 

and end within the bounds of the interval. The Simulation slider will show this by 

drawing a blue line under the slider. If this check box is clear, tasks that begin and 

end within the bounds of the interval will not be highlighted in this manner, and 

will need to overlap with the current date in order to be highlighted in the Scene 

View.  

You can define the overall Playback Duration for the complete simulation (the time 

needed to play it through from start to finish). Use the Up and Down arrow buttons 

to increase or decrease the duration (in seconds). You may also enter a duration 

directly into this field. You can define whether the current simulation date should 

be overlaid in the Scene View, and if so whether it should appear at the top or 

bottom of the screen. From the drop-down, choose from None (to display no 

overlay text), Top (to display the text at the top of the window), or Bottom (to 

display the text at the bottom of the window).  
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You can Edit the information displayed in the overlay text using the Overlay Text 

Dialog Box. This dialog box also makes it possible to alter the Font Type, Style 

and Size by clicking on the contained Font button.  

You can add animation to an entire schedule, so that during the TimeLiner 

sequence playback, Autodesk Navisworks will also play the specified viewpoint 

animation or camera.  

The following options can be selected in the Animation field:  

 No Link: no viewpoint animation or camera animation will be played.  

 Saved Viewpoints Animation: links your schedule to the currently selected 

viewpoint or viewpoint animation.  

 Scene X - Camera: links your schedule to a camera animation in the selected 

animation scene.  

You can pre-record suitable animations for use with the TimeLiner simulation. 

 Using animation also affects the Animation Export.  

 

View area: Each view will playback the schedule depicting Planned and Actual 

relationships:  

 Actual. Choose this view to simulate the Actual schedule only (that is, only 

use the Actual Start and Actual End dates).  

 Actual (Planned Differences). Choose this view to simulate the Actual 

schedule against the Planned schedule. This view will only highlight the items 

attached to the task over the Actual date range (that is, between Actual Start 

and Actual End. See diagram below for graphical representation). For time 

periods where the Actual dates are within the Planned dates (on schedule), the 

items attached to the task will be displayed in the Task Type Start Appearance. 

For time periods where the Actual dates are early, or late in comparison to the 

file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-D27867BE-1D7B-42F1-9015-19288EBD91BC.htm
file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-D27867BE-1D7B-42F1-9015-19288EBD91BC.htm
file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-9FCF9AA7-07FD-42B1-B483-AF543B0E73C6.htm
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Planned dates (there is a variance), then the items attached to the task will be 

displayed in the Task Type Early or Late Appearance, respectively.  

 

 Figure 34 graphical representation for Actual (Planned Differences) 

Actual dates are early 

 

 

Figure 35 graphical representation for Actual (Planned Differences)  

Actual dates are late 

 

 Planned. Choose this view to simulate the Planned schedule only (that is, only 

use the Planned Start and Planned End dates).  

 Planned (Actual Differences). Choose this view to simulate the Actual 

schedule against the Planned schedule. This view will only highlight the items 

attached to the task over the Planned date range (that is, between Planned Start 

and Planned End. See diagram below for graphical representation). For time 
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periods where the Actual dates are within the Planned dates (on schedule), the 

items attached to the task will be displayed in the Task Type Start Appearance. 

For time periods where the Actual dates are early, or late in comparison to the 

Planned dates (there is a variance), then the items attached to the task will be 

displayed in the Task Type Early or Late Appearance, respectively.  

 

Figure 36 graphical representation for Actual Planned (Actual 

Differences) Actual dates are early 

 

 

Figure 37 graphical representation for Actual Planned (Actual 

Differences) Actual dates are late 

 

 Planned Against Actual. Choose this view to simulate the Actual schedule 

against the Planned schedule. This will highlight the items attached to the task 



115 
 

over the entire Planned and Actual date range (that is, between the earliest of 

Actual and Planned Start dates and the latest of Actual and PlannedEnd dates. 

See diagrams below for graphical representation). For time periods where the 

Actual dates are within the Planned dates (on schedule), the items attached to 

the task will be displayed in the Task Type Start Appearance. For time periods 

where the Actual dates are early, or late in comparison to the Planned dates 

(there is a variance), then the items attached to the task will be displayed in the 

Task Type Early or Late Appearance, respectively.  

 

Figure 38 graphical representation for Planned Against Actual.  

Actual dates are early 

 

 

Figure 39 graphical representation for Planned Against Actual.  

Actual dates are late. 
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The Export Animation Button: 

The Export Animation button opens the Animation Export Dialog Box that 

enables you to export a TimeLiner animation to an AVI file or a sequence of image 

files.  

The Task View: 

All active tasks are show in a multi-column table. You can move and resize table 

columns, if necessary.  

You can view the current simulation time for each of the active tasks, and how 

close to completion they are (Progress is displayed as a percentage). The Status of 

each active task is also displayed as an icon. For simulations where Planned and 

Actual dates are available, the status provides a visual representation as to whether 

there is any variance between the planned and actual dates.  

The Gantt Chart view: 

The Gantt Chart displays a colored bar chart illustrating your project status. Each 

task takes up one row. The horizontal axis represents the time span of the project, 

broken down into increments (such as days, weeks, months, and years) and the 

vertical axis represents the project tasks. Tasks can run sequentially, in parallel, or 

overlapping.  

The visible range (zoom) level is determined by the Interval Size options in the 

Simulation Settings dialog. 

file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-164E5676-EECE-46B5-8027-0699B5A4DECB.htm
file:///C:/Program%20Files/Autodesk/Navisworks%20Manage%202014/en-US/html/files/GUID-E296880A-1607-4755-9A99-D92ECD43463E.htm
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  بسم الله الرحمن الرحيم

Appendix 2 

Sudan University of Science and Technology 

College of Graduate Studies  

Questionnaire 

Dear respondent, 

This questionnaire is for academic purpose only. It is designed as one of the tools for 

collecting data concerning the subject matter. Please answer the questions laid down to the best of 

your knowledge; Be insured that this information will be confidential and used for academic 

purpose only as indicated above. It takes approximately 15 minutes to answer the questionnaire.    

Thank you. 

Part One - A: General Information 

Please choose the appropriate choice by putting (√) 

1. Respondent’s Gender, Specialty and Educational Qualifications: 

Education level:       Diploma                  Bachelor               Master                    Doctorate       

Specialty:                  Civil Engineer                 Architect                    Other                                  

Gender:                      Male                                Female        

2. The position of the respondent: 

                        Director                                                   Deputy Director 

         Project Manager                                              Site/ Office Engineer 

3. The sector type you work for:       

            Public                             Private                      Other  

4.  Years of experience in construction projects: 

                        0 – 5                  5 – 10                 10 – 15                 More than 15 

5.  Have you ever worked in construction projects outside Sudan? 

                        Yes                                 No 
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Part Two: General concepts of Building Information Modeling (BIM) 

Note: Building Information Modeling (BIM) concept is collect of whole information related with a 

building in one model, allow to all whose involved in design, Build and operate the building for 

working on central model, helps to coordinate and control the intersections in-between them.  

1. Your level of familiarity with BIM concept. 

    Weak            Medium                    Good            Very good           Excellent  

 

2.  Have you ever applied BIM technics during your work in construction projects? 

                       Yes                                 No 

 

3. Your experience with BIM technics in construction projects. 

 

            Weak            Medium                    Good            Very good           Excellent  

 

4.  How much do you want to know the concepts BIM in construction projects? 

 

            Weak            Medium                    Good            Very good           Excellent  

 

5. It is important to use BIM software to manage the construction projects in Sudan: 

 

         Strongly Agree              Agree            Somewhat                       Disagree 
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Part Three: Usage of (BIM) fourth dimension technique in construction 

projects at Sudan. 

Note: Fourth dimension mean the output from connect 3D model with time dimension of project, 

by using software to connect between 3D model and schedule. 

1. The high level administrations in companies that working in AEC industry at Sudan 

accept the concept of applying BIM in their projects. 

 

        Strongly Agree               Agree            Somewhat                       Disagree 

 

2. Which type of software that supports BIM-4D concept is used in your projects? 

(You can tick more than one) 

            AutoCAD                            Primavera                Rivet  

             MS. Project                      Navisworks              Others 

       In case of choose other please mention it ………………….. 

    

3. The output from connect between the 3D model and schedule of the projects is 

simulation of construction scenario and its enhancing sharing knowledge between 

stakeholders during planning phase. 

               Strongly Agree               Agree            Somewhat                       Disagree 

    

4. BIM-4D contributes by effectively manner in monitoring and controlling the cost and 

time of projects 

               Strongly Agree               Agree            Somewhat                       Disagree 

    

5. BIM-4D contributes in risk assessment processes during planning phase and 

decreasing the chances of issues happening during executing phase 

                     Strongly Agree               Agree            Somewhat                       Disagree 
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 بسم الله الرحمن الرحيم
Appendix 3 

 جامعة السودان للعلوم والتكنولوجيا

 كلية الدراسات العليا

 إستبيان
 الإستبيان لغرض أكاديمي فقط، وهو مصمم بإعتباره أحد أدوات جع البيانات المتعلقة بالدراسة، وذلك هذا

. الرجاء الإجابة على الأسئلة المحددة للحصول على درجة الماجستير في الهندسة المدنية )هندسة التشييد(

خدامها لأغراض أكاديمية بحتة كما بأفضل ما لديك من معرفة. ثق تماماً أن هذه المعلومات ستكون سرية وإست

 هو مبين أعلاه.

 BIMة :                          نمذجة معلومات المباني  عنوان الرسال

 )الربط بين النموذج ثلاثي الابعاد والجدول الزمني لإنشاء نظام البعد الرابع(

 الجزء الأول: معلومات عامة

 الخيار المناسب. لتحديد)√( الرجاء وضع علامة 

 النوع:و المؤهلات العلمية، التخصص .1

 ماجستير          دكتوراة         بكالوريوس           دبلوم          المستوى التعليمي: 

 أخرى .........         مهندس مدني            مهندس معماري                   التخصص:     

 أنثى                 ذكر                                  النوع: 

 نائب المدير                             مدير                       الموقع الإداري: .2

 مهندس موقع/ مكتب     مدير مشروع                                                

 نوع القطاع الذي تعمل به: .3

 .........   عام                          خاص                       أخرى                      

 :مشروعاتفي مجال العدد سنوات الخبرة  .4

 32أكثر من           32 - 30          30 - 2            2 - 0                        
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 أن عملت في مشاريع التشييد خارج السودان؟ لك هل سبق .5

 لا                     نعم                                

 (BIMفاهيم عامة عن نمذجة معلومات المباني ): مالثانيالجزء 

هو نمذجة كل المعلومات  Building Information Modeling (BIM)ملحوظة: مفهوم ال  

المتعلقة بالمبنى في نموذج واحد يسمح لكل المشاركين في تصميم وتنفيذ وتشغيل المبنى بالعمل على نموذج 

 مركزي يساعد في التنسيق والتحكم في التقاطعات في مابينهم.

 (؟BIMبمفهوم نمذجة معلومات المباني ) مامدى المامك .1

 جيد جداً                ممتاز         جيد                         وسط             ضعيف                    

 ؟في صناعة التشييد خلال عملك (BIMوبرامج ال )هل سبق أن طبقت تقنيات  .2

 لا                نعم                                   

 في مشاريع التشييد: (BIMتقنيات ال )مدى خبرتك حول  ما .3

 جيد جداً                ممتاز         جيد                         وسط             ضعيف                     

 في مشاريع التشييد: (BIMال )مدى رغبتك في معرفة مفاهيم  .4

ممتاز            جيد جداً              جيد                        وسط             ضعيف                       
 

 مشاريع التشييد بالسودان:  في ادارة (BIMبرامج ال )هنالك أهمية في إستخدام  .5

 لا أوافق        لحد ما  صحيح         أوافق بشدة            أوافق                        
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 في صناعة التشييد بالسودان BIMاستخدام البعد الرابع من ال  :الثالثالجزء 

 بالبعد الزمني للمشروع باستخدام لحوظة : يقصد بالبعد الرابع هو المنتج من ربط النموذج ثلاثي الابعادم 

 برنامج يربط مابين المخطط الزمني للمشروع والنموذج ثلاثي الابعاد.

الإدارات العليا في الشركات العاملة في صناعة التشييد بالسودان متقبلة لمفهوم تطبيق تقنيات ال  .1

BIM :في مجال عملها 

 لا أوافق           لحد ما صحيح          أوافق بشدة            أوافق                  

يمكن إختيار )؟ ( مستخدم لديكم  (BIMالبرامج الداعمة لمفهوم البعد الرابع من تقنية الأي نوع من  .2

  خيار( أكثر من

                       AutoCAD                   Primavera                       Rivet  

              MS. Project             Navisworks                                 Others 

 ..........................................................................  اذكرها (Othersفي حالة اختيار )

. ينتج من ربط النموذج ثلاثي الابعاد مع الجدول الزمني للمشروع نموذج محاكاة لعملية التشييد 3

اثناء ( Stakeholdersويساعد هذا في توحيد المفاهيم لدى الاشخاص ذوي العلاقة بالمشروع )

 التخطيط للمشروع:

 لا أوافق            لحد ما صحيح         أوافق              أوافق بشدة                                

بشكل مباشر وفعال في عملية الضبط والتحكم في مدة وتكلفة المشاريع   BIM-4D.  يساهم مفهوم ال 4

: 

 لا أوافق             لحد ما صحيح          أوافق              أوافق بشدة                         

في عملية تقييم المخاطر خلال مرحلة التخطيط والحد منها اثناء عملية  BIM-4D.  يساهم مفهوم ال 5

 : التنفيذ  للمشاريع 

 لا أوافق          مالحد  صحيح          أوافق            أوافق بشدة                                

 


